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MSP430 KBRS ROLITH T EEFEE M= miER: WEVIEHAEM F1 M F2 R51,
FILE A Bl LCD IXBhI1 F4 R4 (L iz b F KR FD , BISERA USB IXsh1
F5/F6 241, FIFERCE 1GHz SHHBIEA) cca30 &%), FHRTRE SN IL 62, H 3
KHAFALREHART) FRAM 251 . MSP430 7= i L4 4 |32 3R 21 Tl AR 3 1 45 AN 40
MK R BIRZBRM, S0 R B4 M, MBS 2 B PR B e, 430 1B
FEERACHL OO F P ke, A AEVE R N2 4 SR .

4= |Jltra-Low Power Performance — Analog Integration — Easy-to-Use =—————p

MSP430™

16-bit RISC CPU F5xx/6xx
All devices feature: | 0.9v-1.65V : DAl : Speed: 25 MHz m Speed: 20 MHz
* 16-bit timers Speed: 4 MHz : 0 e : Flash: 8-256Kb Flash: 8-16Kb
» Watchdog timer ROM: Up to 2Kb P 3 B AN RAM: Up to 18Kb
e Internal Digitally : c | GPIO:32-83 MPY

Controlled Oscillator :
* External

crystal support
* <50 nA pin leakage
* <6 ps wakeup

[ |
[ |
ow |

3
5

EE |

Speed 24 MHz Speed: 8 MHz
FRAM 4-16kB Flash: 1-60Kb
GPIO 14-28
Non-volatile
memory
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B MSP430 77 i K itk

[FEf, MSP430 A& KfEH, 25 LFMILH, XN FHIT R A HLE ST 5e 4t TR
KIEFR T8 N E 2], TR T 233 T 430 FF R 2SI, E02e#
SRR E TR, Bilhn MSP430Launchpad, BAKIET F5529 T RMREE. TI
MSP430 2E>]E AT R ETRAE T 8 MBI, R EE W, W R, NAZIRE.
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5" # LLE ] o E MSP430 HUHES SR AR Ty, FEREFEIT AT G MR SRy Bl 4
IR IR o AR5 v B8 AT R 22 A0 U R IR P A AR 22 2 WIS # i  F LB



430, XT 430 P RIEARRGE, AP AL ARE R, S1 3k, JAGE
R DX A /YT 35 BRI fh MSP430 [T K&, fREAEIT RISRE A i — 2L o) 3, 3L
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142 JEFITHTREE oot 17
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2.1, 430Ware fH I oottt 22
3 (] = ol =SS 28
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1. AT RKFFHE CCSV5.1

CCS (Code Composer Studio) & TI AFWIR K —KEEHIRACE . TSR 2
FPR, BRESAI M S D Re AR O R FREE,  BRSFE Bh FH P 8 — MR IR B T 58 g
e, BERE. WIRAEEE TS THE. CCSv5.1 y CCS Bk isahiiAs, ThfgsEsm Ak, P
RESERRE . PTHIMERE i, A2 MSP430 BT K AR T R . FEARTT A B AR 44 CCSV5
(22367575, L MSP430F5529 Jyfiil /48 CCS (1 —Mefdi il 7772

1.1. CCSv5.1 K123
(1) BAT FE 223 cos_setup_5.1.1.00031.exe, iz THIWIE 1.1 4biF, EF%
Custom &I, N T2k 22 25 WiE .

Code Composer Studio 5 Setup

Setup Type ! ' 1
Select the setup type that best suits your needs. ‘

Click the type of Setup you prefer,
s
[Complete Feature Set Select this option if you wish to

customize the individual features that

are installed.

[ < Back ] [ Mext> | [ Cancel

1.1 228 1

(2) i Next 5210 1.2 Fion B 1, N 7T 222, 1Rk R $E s MSP430
Low Power MCUs [T, i Next, fRIFERGNACE, 4ksi4c%h,



Code Composzer Studio ¥5 Setup

Processor Support ‘ 1
Select Processor Architectures to be installed \ l I

Description

MSP430 Low Power MCUs e fe

[ c28x 32-hit Real-time MCUs included: M5P430
[ stelaris Cortex M MCUs

O cortex-RaF MCUs

D AMyxx Cortex-A and ARMS processors —

D Ciax DSP + ARM processors

O oavind video Processors

|

£

[ Select all

Download size: 362 MB. Install size: 1529.0 ME.

[ < Back ” Mext = ] [ Cancel

K 1.2 230 FE 2

Code Composer 5tudio ¥ Setup

CC5 Installation ‘

Code Compaser Studio v5 is being installed on your computer, ,\ I

Installing xdctools_3_22_04_46_base_windows.zip

[----------I ]

Reqistering com, ti, costudio. cosinit.win32 feature

Fegistering com. ti. costudio. msp430, emu, win32 feature
Fegistering com. ti. cgt.dmed.win32 feature

Registering com. ti, cot.msp430.help. 4.0.win32 feature

Installing ti_dspack_setup_5.1.0.539 exe executable

Installing ti_cgt_msp430_4.0.0_setup_win32.exe executable
Instaling idecore_setup_5. 1, 1.M20120106 1800.exe executable
Installing ti_dvt_setup_mini_3.1.0.201201132237. exe executable
Installing wdctools_3_22_04_46_base_windows.zip executable

1=

(£4]

K 1.3 Bffa et




()

Code Composer Studio vh Setup

Code Composer Studio v5
Installation Complete

Code Compaser Studio v5 has been
successfully installed.

Click Finish to exit the installation wizard,

Launch Code Composer Studio v5

P 1.4 BRAF 23R 5E K

(3) #Hik Finish, #1217 CCS, I 1.5 Fntd M, FTIF<RABm, 1ER—/#
FF, BUELL R EAE: AMSP-EXP430F5529\Workspace, it Browse, F# T1F X [H]
ERE R AT SR, R/A)i%"Use this as the default and do not ask again”

E3

¥ Yorkspace Launcher

Select a workspace

Code Composer Studie stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session

Horkspace: |F:\MSP-E}{P*{SUFESQQ\Workspace v| [ Browse. ..

Duse this asz the default and do not ask again

0K ][ caneal

1§ TExAs
INSTRUMENTS

& 1.5 Workspace %% % I
(4) Hifi OK, ZF—IRig1T CCS TaHTIHAM VT ik $e, Wi 1.6 Fior.

eI, #4#% CODE SIZE LIMITED(MSP430)#E1i, fEiZ%i%&Ii F~, %+ MSP430, CCS
o DRI 16KB BIRE 725 18) s & A AT VRRT, AT LS DR BE AT SO VF AT B E :



http://processors.wiki.ti.com/index.php/GSG:CCSv5 Running for the first time, .t Finish
RIAT gk N CCSVh.1 B A A 5E, Wi 1.7 Fiw.

QLicense Setup Wizard : @@

Select a license option

Select one of the following license options:

() ACTIVATE

~ Select this if you have an activation code, license file or license server

() EVALVATE
= Use full featured Code Composer Studio for 90 days

() FREE LICENSE - for use with
- XDS100 JTAG emulators
- Onboard emulators on EVMs/DSKs/Stellaris/eZdsp/MAVEK development kits. Does not support eZ430.
- Linux/Android Application Development using GDB
- Simulators

(5) CODE SIZE LIMITED (MSP430)
= Free 1BKB code size limited tools for MSP430

@ Back Hex [_Finish_ | [ Cancel

K 1.6 BAFVF AT IEREE 1

Welcome to Code Composer Studio v5

19 this poy

B New Project Highlights
'Y o Welcome to Grace
A Examples o System Analyzer
W lugod Projet Getting Started
0

&

P 1.7 CCSV5 AT 5 B A B8 Ft

1.2. i ccsv5.1 BABHE LR

(1) FESEASESS — i TAE 9B BEAT UEAR,  H 5641 9T CCSvA.1 I E TAEX 7). FAMSP-
EXP430F5529\Workspace, i%$% File-->Import 5 i & 1.8 % i&#E, fEH Code Composer
Studio i%#¥ Existing CCS/CCE Eclipse Projects.


http://processors.wiki.ti.com/index.php/GSG:CCSv5_Running_for_the_first_time

Select
Imports existing CC3/CCE Eclipse projects into worlspace.

Select an import source:

= General

= CfCH

== Code Composer Studic
Fi Existing CCS/CCE Eclipse Projects
20 Legacy CCSv3. 3 Projects
|$], Managed Build Macros

= Git

= Install

= Run/Debug

= Team

[ - R

@

K 1.8 5 N\ CCSvb T2 i
(2) i Next 521K 1.9 XHEHE

$Ilport CCS5 Eclipse Frojects

Select Existing CCS Eclipse Project

Select a directory to search for existing CCS Eclipse projects.

@ Select sgarch-directory: |

| [ Browsze. ..

OSelect archive fila: |

liscovered projects:

Browsze. ..

Dgopy projects into workspace
DAutomatically import referenced projects

Open the Besource Explorer and browse awailable example projects. ..

@ ot >

Select 411
Deczelect A1l




19 EFESALTIEHZ

(3) Hi; Browse R F AWM LR HS, fEit, FATER: FMSP-
EXP430F5529\

Workspace\MSP-EXP430F5529 LAB CODE\LABL (FifESb2 /i, K SEEeARHS & i 2] TAEX
R, 53K 1.10.

e Import CCS Eclipse Frojects

Select Existing CCS Eclipse Project 4
Select a directory to search for existing CCS Eclipse projects. :_" 5

(3elact search-directory: |F:\MSE-EXP430FS529\Horkspace\WSP-EXF4! | Erowse... |

OSelect archive file: | |

Discowered projects:

[7]1ET L&B1  [F:'MSF-EXP430FSS29%Y crkspace \WSF-EXF430FSE29 LAE (| | Select ALL

Dezelect AlL

< >

Dgopy projects into workspace
Dhutomatically import referenced projects

Open the Besource Explorer amd browse awailable example projects. ..

@ [ Finish ][ Camcel

K110 iEHFES A LR
(4) ¥ Finish, BIRT5EREEA LRERT SN

1.3. F|FH cCSv5.1 FrE THE
(1) B3I CCSvh.1 I TAEIX ], 4R )51+ File-->New-->CCS Project 5 tH ]
1.11 MHEHE.



CCS Project >

Froject mame! |myeesl |

Output type: |Executa'ble v|

[“]Uze default location

[ Erowse

Dewice

Family [mspasn

Variant: |msP430xSe Family ~ | [T

Connection: |TI MSP430 USEL [Default] ~|

b Advanced settings

w Project templates and examples

Creates an empty project fully
initialized for the zelected dewice.

=-[[=] Enpty Projects
[ Empty Project
[ Empty Assembly—only Froject
[ Empty ETSC Froject
=[[=] Basic Examples
[ Blink The LED
[ Hello World

1.11 ¥k CCS TREXTIEAE
(2) 1E Project name " A\ eE TRERIAFR, TEMHIA mycesl.

(3) 1 Output type FF 43 P§M%ET0i: Executable Al Static library, Rij& AME— e
PRI PATRES Y, 538 ARSI . fEHIRE: Executable.

(4) 7E Device # 7y & B4 1F A5 7R Family 15 MSP430; Variant i #
MSP430X5XX family, ' Fi%&#: MSP430F5529; Connection fRFFERIA .

(5) P THRE, A oy Finish SERGHT TREAIE .
(6) I TR B nrE Project Explorer 11, 1 1.12 s .

%Pruject Explorer 7 = 0

Bg ¥
=l '[E; myces]l  [Aetive — Debug]
bl Includes
| g 1ok m=p430£5529. emd
@ mall. ©
[ MSF430F5529. coxml [Actiwve]

K 1.12 W25 i p 3 AR



FalRs: HEFBRRSADE hBlcX, SPHRNT:

(7) #radt.nh fF: £ LFEA BAB NS, EH New-->Header File 32/ 1.13 XJiHHE,

@lev Header File

Header File

Create a new header file h .
Source folder: |myccsl | ’ Browse. .. ]
Header file: [my0l.h

Template: |Default C+t header template

Finish || Cancel

& 1.13 B .h SO RHEAE
7t Header file I N L ST FR, JERAIILLh SR, 7Rk myol.h,

(8) Wradt.c . £ LR L AR S, %P New-->source file 13 2| 1.14 XTEHE



%) Rew Source File

Source File
Create a new sowrce file. C 1
Source folder: |myccsl | ’ Browse. . . ]

Source file: |myﬂl.c| |

Template: |Defau.'|.t CHt source template V” Configure. .. ]

@ [ Finish ][  rCancal

B 1.14 B .c SCHSTHEAE
£ Source file N ¢ CHFILFR, FERELZIILL.c 45 R, RN myol.c.

(9) FACHN Bc X ETRES AR S, ®&F Add Files 5240 1.15 XTiEHE.

Add filez to myccsl @
SEED: [ eclipse v 02 =

[ﬁconfiguration }eclipse. ini

__J ) dropins Eeclipsec. exe

Recant @features @epl‘vlﬂ. himl

. ) jre @ inztall log

@ ez # notice himl
5 @plugins
C)readne

. eclipseproduct

= artifacts aml

RIS cos. properties
— |2 ces_config xml
e g.; cestudio. exe

FHAIE }ccstudio. ini

[ et Log

= eclipse, exe

-

LSRR

a7 T v [ #FO |
MEEE@D: s v [ mE |

K 1.15 S\ CF X HHEHE
KBRS AMSCAE, BT, 321K 1.16 XEHE.



@ File Operation

(<]

Select how files should be imported into the project:
©Lepy files
(Link to files

Configure Drag and Drop Settings. ..

2 e

Kl 1.16 WSO IA S
% H Copy files, Hiii OK, RIAPE A XS AEI TREF.

O HELERERA (Bl 1AR) , SERR T AN TREMITA, Z LETEHEEREA
CCSv5, {Hu]LLEIL/E CCSvh Hugii A2, IFFRIELER (7) « (8) A1 (9) HEHFA
CA.h flil.c S, T SE A TR R AE

1.4. F|FH CCSv5.1 R T2

1.4.1. I HREE

(D TP R /T, AL EIA BAREE 25 O A0 @ R E Ef . 7EDAsE
36— NBIEATUHAE: EARSALE TR, SABBESSE 1271, wE 117 for, K
H MSP430F5529.coxml H frlic B SO O & IEmfI e, BInT AT 4n R iR, Tof SRl
i HARELE SCPF R G s @A R, IR TR . N T oHE B AR & SO Rl 2, 72
X LABL (1) T2 Ff- 6% H AR & S0



r[i‘lProject Explorer (7 =g

(18]

= = LABl  [Active — Debugl

ﬁ:’;? Binaries=

Iﬂ] Includes

[~ CT3

= Debug

= Drivers

7= FSux_Fbxx_Core_Lih

= FatFs

= MSP-EXF430FS529_HAL

= USE

[ UserExperiencellemo

[ 1ab1. a

[R] 1abl.k

[€] LéBimain. e

| 1ol m=p430£5529_USE. o

| g Lok _m=pd30£5529. emd

@ system_pre_init. ¢
=] macres, ind_initial

i1 [hetive]

=, MSP-EXP430F5E29_1E. 1ib

F5529 Hix
fic & A

K 1.17 LAB1 L%

(2) QU HRCE PRI T . AR H 48R, JFiEFE NEW --> Target
Configuration File.

Fgl’rojecl Bxplorer it =0
E§”
s .
LAB1 [het: -
B b [ Project....
35, Binaries
ﬂ] Includes = Copy Crl4C l_? File
=00 jl’ile from Template
& Debug ¥ Delets Delete [ Folder
[ Drivers 3 y
[ FSux_Féax_Core Li7 ouree ﬂ
(= Fatfs = .
(LS Project
[ MSP-EPOORSSRE K T FZ j ’
(=R ﬂ\_'ﬂlmport... @Ch“
[ VserExperienceDen ﬁzﬂEngﬂ. - ﬁ}{eader File
[€ 1abt. e o
€] Souree File
] Leb.n Show Build Settings.. &
@ LiBtnin ¢ Build Project Sowrce Folder
g Lok nsp30E3528 I8 0 oon Project @C Project
- Ink mspd30£5529.
LS ;"'SP . 9 #| Refresh B @EH Project
- R em_?r.a_lm 'C_ Cloge Project
|=| macros. i _initial ri’mher ) Ctrltd
(&) MSP430FS529. coxnl Build Configuwrations 4
B MEP-EXPA30FSSES W Make Targets 4
Index 4
Add Files. ..
Debug ks 4
Tean 4
Compare ¥ith 4
Restore from Local Histery. ..
Source 4
Refactor 4
Properties MittEnter




K 1.18 G H 0 H br

(3) 7£ File name HH 8N J5 4% ~.coxml [ATC & CAF 42, BTt F5529 JF R B b
Bo B E, Rk, W ECE SO 4 o8 MSP-EXP430F5529.coxml,  #1E 1.19 flfw .

@He' Target Configuration |Z|®

Target Configuration
Create a new Target Configuration file.

File name: |MSE-EXP430FS529. coxml |

I:‘Use shared location

Location: |fU\Bl | [Eile System. . . ] [ﬂorkspace. .. ]

@ [ Finish | [ Cancel

K 1.19 HirBL E 4
(4) s Finish, K479 HirBc B w4, WA 1.20 fis.

) #MSE-EXP430F5528, coml (7 =0
Basic EE
General Setup Advanced Setup

This section describes the general configwration sbout the target

Commection |TI WSP430 TSR [Mefanlt] v‘ Target Configwation; lists the configuration options for the target.

foerd o Teriee |ty‘pe filter text ‘ Save Configuration

[ msp4z0Fs525 A

] Mepegipssas =

[ Msp4zorsset

[] Msp430Fss2a
o

Test Connection

To test 2 connection, all chamges must hawe been zaved, the
configuration file contains mo errors and the connection type supports this
function.

29
[] MSP430FSE30
[] MSP430FSE3L
[ Mspa3orseaz
[] MSP430FSE33
[ Msp43orsead
[] MSP430FSE3S v

MEP430F5529

Hote: Suppert for more devices may be available from the update manager.

Basic| Advanced | Sowrce



K 1.20 H bric B 9w o

(5) ¥ Connection &I #FFERIN: T1 MSP430 USB1 (Default), 7£ Board or Device 3
BRI S, 7R Ii% SR MSP430F5529. LB e 5, Hidi Save, FCECK HEh
BWRESR . WE 121 R, —AMBETUAEZANERRE, HRE - ERREE
RN, BEEERG LA MA HARE, RFEE L View --> Target Configurations 27

[y Project Explorer i3 — q:‘p = =0

= [~ LAB1 [Active — Debugl

+ :jf}p Binaries
[ Ineludes
= CTS

= Debng
= Drivers

= FSux_FBax Core_Lib
= FatFs=

= MSP-EXP430FS529_HAL
= USE

= UserExperiencellema
lc| labl. e

labl h

lc| LaFlmain. o

g lnk_mspd30£5529_USE. emd
g# lnk_mspd30£5529. emd
|\C| system_pre_init. c

e O Oy Oy Oy Oy PR Y PR oy Oy Y oy O

7| MZP430F5529. cexml
=, MSP-EXF430FS529_1UE. 1nb
7 MSP-EXP430F5529. coxml [Active]

M 1.21 BiH S5ECE 5 R H bR SCE

1.4.2. B3RS

(1) Bk LABL TR T4miFidid: 1%+ Project-->Build Project, %% Hbr T2,
FEES — R S g0 TRR, RSN H3) B rtsd30xLIib P, 18R] DL PR 4645 1)
e HATREAE BN IR] . B0, Dy 7 O78, HEFFAESR R R AR SI8 SR A )
rts430x1.lib PE SO E) CCSV5.1 1 BHE U ey, AR AE . -
\tools\compiler\msp430\lib(----y CCSV5.1 ) 2% B 48)

GniEL R, W 1.22 on, FongnERA R4, W T RO AR
iR, Ko AL Problems & HUEoR, MRYEERHIREBEIERR, JFEFHMIF, ERITCHRE
o



&Problems oy = =0

0 items

Description Resouree Fath Lacatia

[
| »

K 1.22 LAB1 T FEifAt4t

(2) ¥ al) Debug Hed ¥ 7 AT FE, B0 1.23 iR i G .

) CCS Debug — LABI/LABImain. ¢ — Code Composer

File Edit YView Project Tools Bun Seripts Himdow Help
[milhe En@8-Dpe- LA B 005 nevg [5C 7
%5 Debug 52 (i3 3R R D - B @Y T O|0-Varisbles 52 |6 Bxpressions| il Registers 2% [0 E@ e Y =0

fa ¥4/ LaB1 [Code Conposer Studio - levice Debugging]
= TI HSP430 VSBI/MSPA30 (Suspended)
= 0 at LiBinain c:98 0x00516A
DE2 (no symbols are defined for Dy3EBZEZ)

A

L

]

=
o

A e N
BEHEHED
\ - = y
K 1.23 AR E DA

(3) g7 Elbs Db g7 R r, MEBRME R AR KK SRS, arEd i
B ACRR R G R E R EN AN E, £ R ARIESE Breakpoints>Breakpoint,
7 25 15 B N SR AR T DL X 2 bR O A% . PRI AT R ey
PUET 8P R = = 2 = e el AP iR, R ERIT R R © 8
fir ) main() R4, BT SR A% AL e R AT T I b T T R [ ) G L

(4 FEEFIRR S, ATCl@Ed CCSVE.L B EL . Zifire. LS paE &
Memory 25 1115 5 TR B P IEITHIE R, PLATIHR 25 Ak T Lbie, AT IR b i il
7. BiSEE View> Variables, 7B E R EME, WK 1.24 .


http://processors.wiki.ti.com/index.php/File:CCSv5_Debugging_green_bug_button.png

(= Yariables 53 | &9 Expressions | ois Registers =0
% e % ot~

L

Hame Type Yalue
()= brightness unsigned char

()= contrast unsigned char

K 1.24 B EEEHE

(5) i View>Registers, 1 LAEE 2 27 (74 1H, WKl 1.25 Fios.

(9= Yariables |07 Expressions il Registers &9 =0
sl =L e =g T
Hame Value ~

# it Core Registers

H b ADC1Z

# M Compar ator_B

# A CROLE

S TMA

# oot Flash

+ B MET_16_ Multiplier_ 15,
# A MPT_32_ Multiplier_ 32,
# bt Port_A

H B pori 1 2

] ff‘ﬂﬁ Port_B

1] ff‘ﬂﬁ Port_3_4

1] ff‘ﬂﬁ Port_C

+ B Purt 56

# M Port D

B Fart T8

] ff‘ﬂﬁ Port_J

] ff‘ﬂﬁ Port_Mapping_Contrel

# 4 Port_Mapping Fort_4

# S PMM__Fower_Management_¢
# B BO__RAM Control Module
] o&m Shared_Reference

# 5 RTC_ Real Time_Clock

+ B SFE_ Special Function ]
# p SIS System Module

# B8 Timer0_sS

# B8 Tineri a3

] n&m TimerZ? A3

# B8 Timer0_BT 2

K 1.25 Ffras G L

(6) midiH View>Expressions, nJUSEIMEE 1, WK 1.26 fros. 0] Lodid
o Addnse PSIIMEASE, BEATTHANERARE EAd, $8 Add Watch Expression
AIEWEEE

(%)= Yariables %CfExpressinns 53 MM Registers =8
% B | 4 it @”
Expreszion Type Value fddres=

=7 Add new

K 1.26 MELE



(7) iR 5 View->Disassembly, A LA RIVC e 7 g s H, ik 1.27 Fios.

‘Disassembly 23 = 3
Enter location here - 27 E=) b e O
main: =5
> PUSHM.A #2,R10
T contrast = *( (omnsigned char
MOV . B &0x1 o, R
Tt brightness = *( (unsigned ch:
2 MOV .B &0x1882,R!
00_sethccel offset (¥ (| (mnsigned
C 4 MOV .B 1884, R!
H in]
H D
H 1 0oDO4 =
WDTCT = WDTPW + WDTHOLD:?
H B2 SA=E D15C MOV W #0x5a80, &1
= Eoard it ()
B202: 1380 E CALLL #Board in
g Se c e(3);
b206: 407C 0 MOV .B
b20a: 13B0 CRLLARE
1 L art (XT1DRIVE_Q) 7
b2 ] CLR.W R12
B2 = CALLE $LFXT_Sta:
134 I L Settle (25000, 7&2);
MOV . W #0
=
#
= a;
CLR.W &SFR__ Specia
| 2

K 1.27 ICSmfe e M2 1

(8) Ai3EH View->Memory Browser, A LASE|INAAEEE H, & 1.28 Fiws.

[J Memory Browser &% #E - PR T e B S |
[Hew Tak |
Dx3a38 Memory Rendering 13 53
[Hex 16 Bit - TI Style Hex |
77BF BDO5 SFFF D397 B2D7 7EDE EBFF CABF -~
EFAT EBEB 8 [ 694F 3BFF BEFF
CFa3 9@FFF DF7F FC3B

FFDEB

SEL3F SDEFS DSRE
ELE7 FBS56 EFDE FOEE
F35D EFEE 6BFS FF1F
§36F E6TS SADF O7FA DEFF SF3D
=7E7 CECT BSEF B666
kConfiguraticoniumkbexs
=FES
tesRemainingon
sBD

TesRemainingCnoEED

EAEE

CRZE

EFPOD

EFOB
c7DC
OxOOIRC2 pkOEPOBuffex

DFOO
abUsbRegquestRetu
Cl8E DBFF FSFF 7
Ox003ADO abUsbReqgquestIncomingDatca

Ox003RDO B7FD S7DF FFAT D&57T

OxOO03RADE akramSerizlStringDescriptor

OxO0O034 EFFF

Ox003ADR D3AF FL93 578D FFFA FEF7 EFFD ASFF F3CF
Ox003AFR 6FFF FB1F 715C BBCD C676 997F FEBD TEAD
OxQO3RFR kStatushction

OxXOO03RFR Q0CEF

robats

£

Kl 128 NFEEH M

(9) iz View->Break points, A PASRIWr b &FH & L, WK 1.29 fis.



(%)= Variables |G Expressions | §if Registers g Breakpoints 53

Tdentity

< i

@ X RE

mEEg~Y~0

Hame

Condition
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2. 430Ware fEHEF
430Ware /& CCS H iy — iy N FH B, 72222 CCSV5 Ik AT e 5 [F] I 22 3¢
430Ware, 7E TIH M 3L FH 1) 430Ware 222427 T %K.
Chttp://www.ti.com/tool/msp430ware )

£ 430Ware H10] LLZE 5 Hidk 1] MSP430 fir 5 % %1124 5[] Datasheet, User’s guide LA & 2
ZHIFE, UhAh 430Ware IEFRHE T K Z 8 T I RIR (FREEsEBiH) WA 485, MO
SR PL R SRR . AR FS FD F6 RS 7RSS, LAJTE P AT BRI
TR

2.1.430Ware {3 F 180

7£ CCS Fr#idds “view” -> “TI Resource Explorer” , £ 18 A2 Son i B A= i

I e, Package £ lf) T~z g H A mr LAEE H T CCS w23 Fr A Bt i . 7
package 5% 1) T+ 3% # b i % MSP430Ware, #E A 430Ware [ 71 .

«' CCS Edit - TI Resource Explorer - Code pos =
File Edit [View| Navigate Project Run Scripts Window Help
=% - | @ TIResource Explorer 5 it 5 %5 CCSDebug [0~
[ Project| [( Project Explorer l5 uuuuu Explorer 5 =0
B Outline A
[ Problems kages: [Al -] Devices: [an =] Topics: (4l N e
B Console -carch keyword URL: M
% Debug B Welcome
[ Target Configurations f controlSUITE
§ B @ TI Resource Explorer
Seripting Console
= Disassembly A place to browse examples, documentation, and online content.
@ Memory Browser
% Registers Filters at the top of this window can be use to narrow down the content displayed in the left pane.
6 | B + "Packages” filter will limit the available content in the left pane to the currently selected product package item
oo Vs «+ "Devices" filter will further narrow the content that is applicable to the selected device item
. « "Topics” works the same way as the "Devices” filter, it further narrows the content that is applicable to the
D | Befeain selected topic item
Other... The free form filter in the left pane accepts keyword(s), content that match the keyword(s) will be displayed in
the left pane. You can use "*" for wildcard and "|" to separate more than one keywords. Use the Back and
Forward button at the top of this window to navigate between last viewed pages.
#, These are some available examples and documentation that you can download and install, click
on the link for more info.
+ StellarisWare #
PRRTSNT. T, . o
| =
B Console 3 o > [ = = O ||l problems 12 ¥ =8
Mo consoles to display at this time. 0 items
Description ‘ Resource Path
D
* Licensed

& 2.1 Tl resource explorer F[f]

1E 430Ware ST AN AT LA 31 3 ANF30 5, 25l Device, B MSP430 i fy
(K] 251845 ; Development Tools, LI fH5 TIMSP430 %) — L8 K BBk
Libaries, .7 7 A HT F5 F1 F6 R4 159KE0 e Z A K USB 12K E) R £


http://www.ti.com/tool/msp430ware

4 CCS idit - T Resource Explorer - Code Composer Studio - - — p— —_—— [ -l
file Edit View Navigate Project Run Scripts Window Help
ri g g ES v v T % CCSDebug [
[ Project Explorer 1% = O | {/) T1 Resource Exploter i3 =0 l
= 7w,
Packages: |MSP43CWavE ¥ | | Devices: |All *| Topics | All ;JJ = J
enter search keyword |
€ Dovicss Welcome Devices Jev t Tools braries Contact Us l
F Development Tools
3 Lioraiies
1.00.01.00
Welcome to
Quicken your develcpment time with MSP430ware, a brand new tool for navigating the available
2t support all MSP430 devices. Using this GUI or clicking through the folder tree to
the left, we offer code examples, software libraries, datasheets & other resources - all at the tip
of your fingers. Here’s how to use MSP430ware:
Find your resources by evelopment Tools or by Libraries. The folder structure
to the left willautofilter ng you with relevant code exemples, documencation &
3 leeper into MSP130ware!
is is @ beta so we would love your feechack! Click the “Contact Us” now
tabto let us know what youthink.
»
]
Bl Zorsole I af - 5= = O||[E Problems 52 v =0
o consoles to disolay at thistirre. 0 itzms
Licens=d i

2.2 TI MSP430Ware FL1f]

B SRRET I A N, AR NCSRER, 1l LA 2ITE Devices T H N HETATA
1) MSP430 [, FREEFEMHEARAS, B4 MSP430G2xx, [FIFEH.& CFRi =M T
i, 767 HRAT AR Fi% R 5[ User’'s Guide, 78 FH /5 55 Th A 4% £ 51) MSP430 (]
CPU LS MR, QIEZFAARECE, TAESR MR BAE R R a] AR 21
1% 2511 Datasheet, 0d FHHE 5 BARRIE S A, FrUAfE datasheet [T H & F
B HARA RS s T 5 7R IX B mT AR B (12 2505



»"+ CCS Edit - TI Resource Explorer - Code Composer Studio

1
1

[E=RTad >

File Edit View Navigate Project Run Scripts Window Help
(S v s § v B Gy

[ Project Explorer &2 = 8 || (/) TIResource Explorer £3

Packages: [MsP430ware

& MSPA30F2xx

4 & MSP430G2xx
) User's Guide
@5 Datasheets
@4 Erratasheets

@0 Code Examples
G Grace Examples

& MSP430Fdxc
& MSPA30FSi/6c
& MSP430FRax
& CCH30Focx
& MSP430L092
IF Development Tools
P Libraries

& Console 2

No consoles to display at this time.

Devices

MSP430ware

1.00.01.00

MSP430F1xx MSP430F4xx cca30
Sub-1GHz RF SoC

D X s B

MSP430F2xx MSP430F5xx/
6xx

* h

MSP430G2xx MSP430FRSxx

[3 v = B[ Problems 52

0 items

2.3 MSP430Ware 7& i 430 4= R 417

B %5 CCSDebug (1

£ 430Ware IR AR 5 1) CCSnBlRE /T, BLAET Grace MBI T k&S
%, AT E, f£ANE D TR SREBNS RO . NEIFRE & T
MSP430 [f15h5t, 430Ware it 13T I SIS HHIRE, NoRBIRER 14 7 Al LA
BRI LA, R R e n] LUE BI5¢ Tz IR R fa ffig, # B P

AP LS EIE S SEp A iuE ey s o



S .
¥ CCS Edit - Tl Resource Explersr - Code Composer Studio_ I =g NN N e

File Edit View Navigate Project Run Scripts Window Help

i~ R~ (- i iE IO [ %5 CCSDebug (B
7 Project Explorer 53 = 0| (/) TiResource Explorer &3 | =F
8% 7 Packages: [MsP430ware ] Devices: [an =] Topics: [an fﬁ \:j =
enter search keyword URL: -
4 & Devices P B

o o MSP430FLx

o o MSPA30F2c

4 & MSPA30G2ex
) User's Guide

1+ %% Datashests

MSP430G2xx3 C Code Examples

Emepd3082x13 ca 0l.¢ - Comp & Output Reference Voltages on P1.1

s

Emspd30g2x13 ca 02. ¢ - Comp_A, Detect Threshold, Set P1.0 if P1.1 > 0. 25+Vec

m

1 ¥ Erratasheets . gmspﬂﬂ 2x13_ca_03.c - Comp_A&, Simple 2.2V Low Battery Detect

4 %5 Code Bramples o Bmpd3022x33_adel0_0l. ¢ - ADC10, Sample A0, Set P10 if A0 > 0.G+AVec
@ MsP430G201 o Bmepd3022x33 adel0 02.¢ - ADCI0. Sample Al 1.5V Ref, Set P10 if AL > 0.2V
@ MsPa30G2AL o Bmepd3022x33_adel 03, c — ADC10, ADCLO, Sample A10 Temp, Set F1.0 if Temp ++ "2C
gngﬁggﬁ . L%mquao 9x33_adcl0 0d.c - ADC10, ADCLO, Sample A1, Signed. Set P1.0 if A1 > 0.5%AVcc
@ MsPa0G202 e o Bmapd3022x33_adel0_05. ¢ - ADC10, ADCLO, Sample A11, Lo_Batt, Set P1.0 if AVec < 2.3V

Emspd30g2x33_adel0_06.

s

<
c
c
c
<
@ MsP430G2x12 ¢ — ADC10, ADCLO, Output Internal Vref on F1.4 & ADCCLE on P1.3
@ MsP430G2:32 Emepd30g2x33 adell 07, c — ADC10, DTC Sample Al 32x, AWcc, Repeat Single, DZO
@ MSP430G252 o Emepd30g2x33 adel0 08.c — ADC10, ADCIO, DTC Sample Al 32x, 1.5V, Repeat Single, DXO
<
<
c
c
c
<
<

@ MSP430G203 Emspd309x33_adel0 09.c - ADC10, ADCL0, DTC Sample ALO 32x, 1.5V, Repeat Single, DCO

@ MsPa30G243 + Emspd302x33_ade10 10.c — ADCLO, ADCLO, DIC Sample A3-01, AVce, Single Sequence, DOO
@ MsPa30GBa3 o Enepd3022x33_adel 11.c — ADCLO, ADCLO, Sample Al, 1.5V, TAL Trig, Set PL.O if » 0.5V
[ MsPaz062:53) o Emepd3022x33 adell 12.c - ADCLO, Sanple AT, L6V, TAL Trig, Ultra-Low Per
“G Srece b o Emepd3022x33_adc10 13.c — ADCLO, DIC Sample Al 3%y, AVec, TAO Trig, DCO
: g Neree + Snopd3032555_adel0_1d.c — ADCLO, DIC Sample A0 16%, Voo, Fepsat Seq, DCD
S G MSPMI0GZa N + Erepdi0g2:55_adel0_LE. ¢ ~ AICLY, ADCLO, DTC Sample A0 = TAL, AVos, DOD
b s ki s Emzpd30g2x33_adell_temp.c — ADC10, Sample AlO Temp and Convert to of and of
b 4 MSP430FSi00/6ac o Emepd30e2zx3 1. c - Software Togsle PL.0O
o & MSPA0FRxc + Emepd3022xx3 1 vla c - Software Toggle P10, NCLE = VLO/8 5
b & CCA30Fox e

Mo consoles to display at this time 0 items

E console sz} # B~[rj~ " ﬁ”& Problems I3 ¥ =E
I
1L

Licensed

K 2.4 430Ware F IR BIFE T

RIS HGIRE, 7R3 ROEHE S B R H AR S 5.

¥ CCS Edit - TI Resource Explorer - Code Composer Studio i e - = 2
File Edit View MNavigate Project Run Scripts Window Help
- Lt v E oo I %, CCS Debug [~
&5 Project Explorer &2 | = O || Tl Resource Explorer 22 | =8
P .
BES Packages: [MsP430ware =] Devices: [an =] Topics: @ \b =
enter search keyword URL: -
F Devices - =
ooy MSP430G2xx3 C Code Examples
& MSP430G2ix L
) User's Guide . '%mspﬂ[) 2x13_ca_Ul.c — Comp_A, Output Reference Voltages on P1.1 1
0 Datasheets o Enspd3029x13 ca 02.c - Comp b, Detect Threshold, Set FL.O if PI.1 > 0.25%Vec
0 Eratashests o Bnepd30g2x13 ca 03.c - Comp &, Simple 2.9V Low Battery Detect
% Code Examples o Sample AQ, Set P10 if A0 > 0. 5¥AV
@ MSP13062:01 &5 Device Selection =) S s = Shrce
- |Sarple Al, 1.6V Ref, Set P10 if AL > 0.2V
gm;‘::iggi‘lﬁ Devices: [MSPA30G2113. = £10, Sample A10 Temp, Set P1.0 if Temp ++ “2C
@ Pz MSPA30G2113 C10, Sample A1, Signed, Set P1.0 if &1 > 0. 5#AVec
e MSP43062153 C10, Sample All, Lo Batt, Set PL.0 if AVec ¢ 2.3V
@ MsP23062:02 3 MSP430G2203
@ MsPe06212 | Mephoozats £10, Output Tnternel Yref on PL 4 & ADCCLK on P13
@ MsPaz0G2a2 = MISP43062233 TC Sample 41 32Zx, AVce, Repeat Single, DCO
= MSP430G2253 . :
@ MSPa30G2i52 + EspanGass ADC10, DTC Semple Al 525, 1.5V, Repeat Single, DOO
® MSPa3062:03 . e ADC10, DTC Sample ALO 32y, 1.5V, Repeat Single, DCO
@ MsPa30G2a3 . %MSW“GBE ADC10, DTC Sample A3-01, AVec, Single Sequence, DCO
@ msPa3062:33 o [EMSPI3062353 ADC10, Sample Al, 1.5V, TAl Trigz, Set P1.0 if » 0.5V
& MsP13062:53 . Sample AT, 1.5Y, TAl Trig, Ultra-Low Pur
G Z“;;‘:}";ZZ; « Epispaogas DTC Sample A1 3%x, AVee. TAO Trig, DCO
G MSPA30G22 » = MSP430G2453 DTC Sample 41-0 16x, AVcoc, Repeat Seq, DCO
G MSPA20G2a B . e ADCL0, DTC Sample A0 —> TAl, AVec, DCO
& MSPA30FdR . EIO Sample 410 Temp and Convert to of and of
F MSP430F5006xx o Emspd30s2ex3_1. c — Software Togzle P10
& MSPA30FR o Bnepd30z2xx3_1_vlo.c - Software Togzle P1.0, NCLE = VLO/8 -
& CCa30Rox -
B Console 23 | 4 B~ 05+ = 5[l problems 52 =3
No consoles to display at this time. |0 items |
| I

Licensed

2.5 § N 430Ware IR BIFE R

f@diX—WE, CCS K HEIEM M T 1ZaBIIE PRI TR, M7 BRI AT 4 %,
S



7t Development Tools f)F H S a] LLFRF TIJE T MSP430 (T &I, #7> Hi CL4 %
BIEBA, BANEA SRS AE 430Ware FRBgh T EERZ LU (A P AR A . 7E
% H 3T AT RAJ R B4 RS R RN e e, R PR I DL S B

¥4 CCS Zdit - T: Resource Explorer - Code Composer Sudio [P —— - = | () ]
file Edt View Navigate Project Run Scrpts Window Help
ri~ it Cera [ %, CCs Debug [
T Project Explorer 2 = O [7) TIResource Explorer 3 =8
=l !,7‘“ —

Packages: [MsP43tware | Devices: (a1 »| Topics Al

= mspd3092:33 adcl0 12
[} Includes enter search keyword URL: -
2 Ink_mspdz0gZ113.crrd
€] mspa30g2:33_2dcl012.c of MSPI30L092
%) MG Bccmn [Acive) | |+ F Development Tooks
- : . %% MSP-EXF430G2 (LaunchPad)

@4 MSP-EXF430F5529

@0 MSP-EXF430FRSTI0

@4 MSP-FET430UTF (USB Dbugging Interface)
. % MSP-GANGA3D iGANG Programmer)

@ MSP-TS430PWL

@ MSP-TS430L092

@ MSP-TS430PW24

@ MsP-TS4300W23

@ MsP-TS430PW23

@ MSP-TS430PW23A

@ MSP-TSI300ATS pull-upipull-dowr re:

@ MSP-TSB00FN23:0

(@ MSP-TS430RSBAD

@ MsP-Ts4300L48

@ EMI3DFSI37RF00

@ MSP-TS430RGZ4E8

@ MSP-TS430PM6S

@ MSP-TS430PME4A

@ MSP-TS430RGCE4USE

@ EMI30FEI37RFI00

@ MSP-TS430RGCE4B

@ MSP-TS430PN20

@ MSP-TS430PNSIUSB

@ MSP-TS430PNE0A

@ MSP-TS430PZ100 - 7]

Devices

¥ hide description

MSP430G2xx

tie Very-Low pow

~ 4~ = O|[E Problems 52 =0
Ho consoles to disolay at thistirre. 0it=ms

Licenszd

2.6 430Ware 1.7 T1430 JT KR & K

FEH P EEBA TR, TIZH T MSP430 AR S 0K 3) PE sk g, IXREFH ) DA
AL 2 L H R EFA S E . X r] PLAE 430Ware [ Libraries + H 3¢+ 7 {8
MR F|. HATXF DriverLib #5372 X BRT MSP430F5 il F6 251



<7 CCS idit - T Resource Explorer - Code Composer Studio | ™
File Edit View Mavigste Project Run Scripts Window Help

O i i LERCE IR I % CCS Debug [F1 7
T Project Explorer (/) ource Explorer =
Project Expl b = 0 ||[Z) TIRes Expl x| [=]
2% - . ‘ ‘ A
Packages: |MSP430ware ~| Devices: | Al +| Tepics: | Al Ea ) =
& mspa30g233 add 012 9 Wl = =
! Includes enter search keyword URL: -

% Ink_mspdZ0gZl13.errd
[& mspd0g233 add012.c
) MSP4GA1Zcoml

4 fF Devices . Eevices
+ o MSP430FLc

& MSP430F20x

& MSP430G2uc

MSP430F4; . -
: MSP‘GUF;}:{{'E)G: A hide description
& MSP430FRioc
& TP MSP430G2xx
S YL ) —
¥ Devel ook MSP430G2xx 16 bitMicroconiroller Series — The
J Deveopment Teols Gk 1 ntrellerValue s eries ‘eatures flash-

4 [ Lioraties

4 ®F Driverlib
] User's Guide
@ APIFunctiors
2 Liorary Project
%0 Bample Prosects

. % USB Developers Package
-] USB API Programmer's Guide
| USE Fiele Firmware Updates
A USE HID Wirdows API Programmer's Suidd
3 USE Descriptor Toa!
%6 Example Pro_ects

d Ultra-Low Power MCL plo 15 MPSwith 1.3V
operaton. Indudes he Very-Low power O or (VLO
ourt options

Bl Zorsole 2 i

No consoles to disolay at thistime. 0 items

G v = O [ Problems 5% ¥ =0

Pl m b

o° Licenszd

2.7 430Ware L7 430 JF & KX A) 2

HIT FARFE AR LLEH, 430Ware & — AN EEWA A T E, R 430wWare v LAMR J7 §
HoFR AT 430 FF A AT TR B A — Lo B, WP, BURFMASEHIRE.



3. Grace

3.1.Grace ¥/

I A B WL R B e K PR B — AT el e X B L A 2 B AR A . Cl
B A A AR L B AR SR UL & e %, UHX T2 E M S . CCS ALY Grace 8+
DU AT DA BhA) 2 2 o8 R B 25 A7, R BRI T — A i REAL I 4 A2 5 3K
Grace 5 TI #EH B RAE CCS Hh ) — 3k 8 5 5 I ETEAL 110 5 AME I E By, &5 T
GUI 11 1/0 54MEICE A TR, H AR5 A4 MSP430F2XX/IG2XX #+ff, JIfH.
RIS FF F5 f1F6 241,

Grace 3T AN 53 BE 6 il B A= Jld A 475 4 T VAR A 7 B 5 132 1 C ARG IR DR 52 LA M3 1
Mo &, MM Grace fREGHIZER, R ZNIT AR AR, IR G n] AAEE B Y 52 1K
MSPA30 5 7 HLEI /MR G RC B, JF T AAE R C 18 5 AU, ORI 1 T A AE7E I
it N P ST Bl

3.2.Grace &%

Grace #M-A M FIE: —&AE A Code Composer Studio(CCS)H—MdEifE, £ CCSV5
WA, Grace fEN— MG 4 A3 2 Hd, WM AT CCS A S BL, &AH
5% %% Grace $iff, WA CALE TUE M L N4k Grace #iff, 2% /5RInM i H; —&
Standalone FRAS, 7EIXFPIEHL T Grace AL FATTgmFIAEEI81T, 1 LATE FEiN L7847,
FFARN G T B R B & AR A QR & 1) 21 TR AR BT

3.3.Grace JF & 5245
FIF Grace SZHL LED [AKR, INRRATZR ARSI K — K.

3.3.1. BIJ# Grace Tf&

WK 7R, $TJF CCS, Project->New CCS Project, 3 H i F4HEHE, 4\ G 9 T
A PR GBS0, 4RBEAE Device fEHP G FERZ51F, Family &% MSP430, Variant
PR ATEFH S A B, a0 MSP430G2553, ] LLTE A [HI F9 ik 918 SC 4 AAE A 4 X BT FH
RS et BE Tk €. 7E Project templates and examples HE H1i% £ Empty Projects->Empty
Grace(MSP430) Project. HAx TR FFERIARIT], s57 Finish 525k Grace TREMIAI%E



~» New CCS Project

CCS Project — %
Create a new CCS Project.
Project name: | LED Blinking
Output type: | Executable v
Use default location
Device
Eamity: [Mspaza v
Variant: | MSP430Gox Famiy v | [Mspa3n62553 v|
Connection: | TI MSP430 USB1 [Default] v|

» Advanced settings

 Project templates and examples
pe filter text Enables the use of Grace within your ~

project so that you can graphically

Empty Projects ||| configure your peripherals, generate
[ Empty Project runtime intialization code, and call this
[ Empty Assembly-only Project code from your application.
= Empty RTSC Project - This project's application code simphy
=] Ermpty Grace (MSP430) Project calls the generated initialzation code and
Basic Examples — || exits. =
| Blink The LED
=L Helln Warld * | | Many more peripheral-specific examples
| & are available in the Grace Examples v
@) [ < Back [ Hext = ] [ Finish ] [ Cancel

K 3.1 ¥z grace T/%

3.3.2. ¥ Grace IE 1/0 O R4k
FREEESG, CCS e — NN T Grace 1 TFE, FHET —#% CCS T.f2, Grace
) TREP 2 — AN a8 .cfg R B SCPF. Sl ix AN, H P ar RO MSP430 i 4h stk

T E.



T TR ARV BTN, T o e N S p— RS
File Edit View MNavigate Project Run Scripts Window Help

B B~ it iy E] e B % CCSDebug [B1
[ Project Explorer %2 = 0|2 maincfg &3 & mainc | utline 52 | B
=SR-3 AG
race - Welcome $ @
i o
L5 ADCI0 ex! AVec Reference type fiter text
5 LED Blinking [Active - Debug] Welcome @ BCSplus
&) Includes ® L
|4 Ink_msp30g2553.cmd = a e ® GPI0
[€] main.c . ) . @ Program
The Grace tool s 2 plug-in to Code Composer Studio that allows you 2s an MSP430 developer to generate peripheral set up code within minutes.
(& main.cfg [Grzee] P ’ ; A A ® System
S Along with each peripheral module typical application use cases are provided, consisting of easy-to-follow steps for the initial peripheral setup as wora
B makefiledefs well as ready-to-use code snippets for peripheral runtime cantrol that can be capied straight info your application's main() code. ® plus
4] MSP43062553.coml [Active]
T Getting Started ~ More Information
1. Click on the Device Overview button to see the peripherzl modules  »  Additional information on how to use Grace can be found on the
available for configuration (depicted in blue) Grace Wiki
2. Click on the peripheral module you want to configure * In-depth peripheral specific information is available in the
MSP430x2s¢ Family User's Guide
3. Follow the use case instructions o freely configure your device
Note: You can copy example code from any use case by selecting ¢ Grace Product Release Notes
the text and using the right-click context menu and paste directly o Pleose post your questions and fecdback to the MSP430 E2E
into your application Forum e
4. Select Project -> Build All to build your project or press the Debug
ican to build and load your project onto your connected target
device
Grace | Source|
E Console 2@\ 0= I A EH& Problems 51 = ﬁ”ﬁmanab\evmduns b =0
No consoles to display at this time. 0 items
4 m, 'l play ” .1 tvoe filter text
o Licensed
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FERC B SO E 7 AT DAE B =M% Welcome, Device Overview 1 System Register,
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&4 Grace - Welcome &

G
=

Welcome :[Dewce D\rerwew] [ System Registers{

~ Introduction

The Grace tool is a plug-in to Code Composer Studio that allows you as an MSP430 developer to generate peripheral set up code
within minutes. Along with each peripheral module, typical application use cases are provided. Each of these consist of easy-to-follow
steps for initial set up of the peripherals as well as ready-to-use code snippets for peripheral runtime control that can be copied straight
into your application.

+ Getting Started + More Information
1. Click on the Device Overview button to see the peripheral » Additional information on how to use Grace can be found on
modules available for configuration (depicted in blue) the Grace Wik
2. Click on the peripheral module you want to configure » In-depth peripheral specific information is available in the
3. Follow the use case instructions or freely configure your MSP430x20¢ Famity User's Guide
device * Grace Product Release Motes

Note: You can copy example code from any use case by ]
selecting the text and using the right-click context menu and * ;;Tiaéirﬂingt your questions and feedback to the MSP420
paste directly into your application E—

4. Select Project -> Build All to build your project or press
the Debug icon to build and load your project onto your
connected target device

K] 3.3 Grace ¥l FHH

Ry Device Overview %4, & R i1 B TR Sh s, HAig e yn]
PLE I AR IC B A . LRI A N A A S brid, RO YT IR
F, ATRLERE AR R A, 8 Use xooox SRSEIUEH A B o 48R AE IEAE (8 T 1)
PR A EE AT DL FE Stop xxxx ReA5E 1L iZ AR H i 4E A .

& Grace - MSP430G2553

Device Overview | | System Registers

HIN XOUT L8V | DvCC DVSS avee P1x P2x Pax
| $ | ta s -8
= =
A v v A A A
v A A A
Osdllztors [P ACLK Flash ADC10 iy P2 Port 3
Basic Clock RAM 1061t
g0 g0 g0
System+ 16kB
© PSucLK | g 51248 | [BChannais | | Intemupt o dntenua
|_ B I5EKE Autoscan capahility capability uill-up.
MCLK %B 1chDMA ull-upidown  Pullupidown down
sistors resistors resistors
Y i
'Y Y ' ¥ AL A A A A A
16MHz MaB
CPU ry
e A J v 4 v \ 4
Registers N Awmoe | A F 3 A
1] Yy \4 Yy Yy Y v
Emulation [
BP 4 USCI AD:
EEP) | UARTILIN,
. Comp_A+ Wiatchelog Timer0_A3 | | Timer1_A3 Il A, SPI
Tag | Brownout WDT+
Interface < Protection 8 acc acc
Channels 15-Bit Regigers Registers UsCl BO
P o SPI2C
Wire Use Timer0_A3
r' Y
Help
RSTMMI
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o CUHRAR RIS Ty, I SRR, SR E RS X E S
Timer0_A3) , IS AHAEH, wILL@EEES Enable Timer0_A3 in my
configuration Fij i) S FEHESRAE H 1A «

& *maincfg &2 [ main.c

Y Timer0_A3 - 16-bit Timer - Overview el &S @D

Overview

[";Enable Timer0_A3 in my configuration:

x lotroduction

Timer0_A3 is a 16-bit timer/counter with three capture/compare blocks. Timer_A can support multiple capture/compares, PWM outputs, and interval timing. Timer_A
also has extensive interrupt capabilities, Interrupts may be generated from the counter on everflow conditions and from each of the capture/compare registers

+ Use-Case: Timer Start/Stop

The Timer can be started or re-started by configuring the MCx bits = 0 in the TADCTL register. MCx bits represent the timer counting mode and MCx = 00 means that the
timer counter is stopped.

User Code:

// Start Timer R
TAOCIL |= MC_1; // Start timer in up mode

/f Stop Timer 2
TROCTIL &= ~({MC1 + MCO); // Clear MCx bits to stop timer

» Use-Case: Interval-Generation using Timer Compare Mode
» Use-Case: Timer PWM Mode
+ Use-Case: Interval-Generation using Timer Overflow

» Use-Case: Timer Capture Mode

Grace | GPIO Timer0_A3 - 16-bit Timer &% | Source

K 3.5 et a e UaC B A

o EhES I ME IR . k¥ Basic User, T LAXHZAEH T —Bufai A1 E
WRFEMATEE . BEEmdnsheg, nl LS Power User HEATHCE .

&9 Timer0_A3 - 16-bit Timer - Overview =

Jvervew || BasicUser | [Power User - CCRO| [Power User - CcR1 | [Power User - ccR2 || Registers |

= Introduction

Timer0_A3 is a 16-bit timer/counter with three capture/compare blocks. Timer_A can support multiple capture/compares, PWM
outputs, and interval timing. Timer_A also has extensive interrupt capabilities. Interrupts may be generated from the counter on
overflow conditions and from each of the capture/compare registers
» Use-Case: Timer Start/Stop
» Use-Case: Interval-Generation using Timer Compare Mode
» Use-Case: Timer PWM Mode
» Use-Case: Interval-Generation using Timer Overflow

» Use-Case: Timer Capture Mode
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T EL Y FE LI LED R FP BN IN — IR, BPREZLP=AE — MR 1Hz 1T, Akt

ACLK AR EPJE, ARIIX B ACLK ERIAAIZ A 12kHz, X EWHE Grace 3AFAER 4 R

Gitidrh A BRI\ ACLK HIIHER IR VIO, 7E0 80 E ARG 8 204, X kEm A

T 7> 1.5kHz B8R, BRI AR R e I S I B A o G R RO e e T

Bz, WAIAIBETE Capture Register FRAI N E: 1X B A) [R]B% A 1HZ, A 4h

A Ay 1.5k, BT LA B EBURECN 1500, S2E 1s FIRWE R . T R E A —
A ERF ARG, BTl et b=, TR I M. EE CCRO FAMARWN
B 2, 3. 6 f1 7, WRKE T HAEM—, Grace 2 A BhHREEHFE R B 1R

Ko X BRI IBR Input Selection A1 Capture Mode P4~ & K th, BIANRESEAT

WPt RURTE S A PR N IX B R T B R A UK, R R AR AL,
IRETR I A 2= W -

FAE N AR RER S/ L b B, X AN IBED A B 5 S E I 2SR 1s BTEAE I — A
Wl SES AT AIRN, XA S TR B AR RS BR A, TR AR T R R
WA . S E IR S RIRAS, RIS SEBRE B PR, SRR R R S
BN PRI FERE A

&3 Timer0_A3 - 16-bit Timer - Power User Mode - CCRO &

[

Owverview ] ’ Basic User ] Powrer User - CCRO ’Power User - CCRl] ’Power User - CCRZ] ’ Reqisters ]

Clock Source Divider 1.5kHz Counting Mode
SmE Mode
Div 16-bit Timer/Counter -
ivider - /4
di-‘

Continuous Mode
Up/Down Mode

Clear

|£| |J__| Enable Timer Overflow Interrupt

Interrupt Handler:

After Interrupt: [Do Not Change Operating Mode % |
Timer Capture/Compare Block #0
Desired Timer Period: 1000.667 ms Time(r) Period 1Hz
Capture Register: 1500 Clock Ticks Time(r) Frequency 1Hz
Input Selection Capture Maode Maode Cutput Pins

Output Mode: [Pym output mode: 0 - OUT bit value | [ Set OUT hit High/Low

Enable Capture/Compare Interrupt

Interrupt Handler,  |TAD_ISR

After Interrupt: [Do ot Change Operating Mode v

P 3.7 52 I A5 PRGN B A T

FEBC B 2 )5 T UL Register REFH T Arfras B —LLAOME . R BRUARES BI2EA T 47
SIS, S BoRIZAL R E LT EE .



ad Timer0_A3 - 16-bit Timer - Register Controls TR ]
E™"Overview 3|  BasicUser | |Power User - CCRa ] [2ower User - CCR1 | [Power User - ccrz | |
TAOCTL, Timer_A Control Register
15 14 13 12 1" 10 a 8 7 a 5 4 3 2 1 a
Unused TASSELx IDx MCx Urusad TACLR TAE TMFG
[acik v| |[oivider /8~ |[upMade v ] O | wwm
TAOCCTLDO, Capture/Compare Block #0
15 14 13 12 1" 10 9 8 7 -] 5 4 i 2 1 a
CMx CCiSx 505 sca Ursed cap OUTMOD= CCE ool ouT ooV CCFC
[Mo capture + || [coma v|| @ Rl 1 | [P output mode: 0 -+ Rl =] mvl | man
Capturefcompare interrupt enable. This bit
TAOCCTL1, Capture/Compare Block #1 the corresponding CCIFG fizg.
15 N 13 12 1 10 9 8 7 8 5 0 Interrupt disabled
1 Interrupt enabled
CMx CCISx 5Cs sca Urusad Cap OUTMODx CCE (=] ouT ooV CCFG
[Mo capture + || [coma v|| O Rl [ |[pwMoutput mode: 0- +|| [ Rl ] I )
TAOQCCTL2, Capture/Compare Block #2
15 14 13 12 1" 10 9 8 7 a 5 4 k] 2 1 a
Cix CCISx BCS sca Urusead CaP OUTMOD= CCE cal ouT ooV CCIFG
lNU Capture v | ICCI)(.ﬂ’u A | D "] D PWM output mode: 0 - |+ D "] D RAv] RAV]
TAOCCRO TAOCCR1 TAOCCR2
150 150 150
1500 0 i

Fh] Read,/Write regi ter not available in GUI

K 3.8 Grace EH| 82 fr 28 41K FLH

PAE, SER T RER RSN RIRCE, Nl sidi 2 N AR Grace ArZEEAH _EAA

E#5, [51%] Error! Reference source not found. = % 47 1I/0 DHIECE . i 1/0
CIBEHR, MR BT FH s b e s el A B, (1) 4%c4H - #E 161645 Pinout 20-TSSOP/20-
TDIP, —7/> MSP430G2553 s et Bl 17, mish Wi to e Nk, XTAHRN 5| I Th R
HHATERBEECE . AY5ikFECE P1.0 N GPIO Output, JHRIKZ) LED.
& GPIO - Pinout 20-TSSOP/20-PDIP G D@
[ Overview J[ pinourzzomn |/ /[ Pnout2sTssor || P1/P2
ovee M1 O 20 [T DvsS
GPIO Output ¥ P1.0[T] 2 19 [[] P26 XIN
3 18 [ P27~ xoUT
4 Ry Tews 17 [ TESTISBWTCK
5 INSTRUMENTS 4 5 T RST/NMIISBWTDIO
6 MSP430G2553 15[ P1.7 ~ GPIO Input
- _ 7 14 [ P16+ GPIO Input
Capacitive seneng 8 13 [T P25 GPIO Input
GPIO Input + P21 [[] 9 12 [ P2.4 ~ GPIO Input
GPIO Input ~ P2.2[T] 10 11 M P23~ GPIO Input
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3.3.3. AR miECHF

it PRI, B AR B R 10 N C AR E TR T, Ik
T UL TR o R a3, Bk TR, ARG ek CCS TAM L & bR, #4745
B, X SPERERIR I, X R EANIA E SRR SS BB E X o A B main
PR % FLTHI A CSL_init()B&i %, 4% Open Declaration, 17T CSL_init.c 30, Bl 7 Project
Explorer " 4& 4TI CSL_init.c 31

+% CCS Edit - LED Blinking/main.c - Code Composer Studio [ - =) S
File Edit View Mavigate Project Run Scripts Window Help
o R~ B P g mEe T %5 CCSDebug [ 7
[ Project Explorer &1 = O [4 mainefg [<] maine 52 =0|gEou. 2|0
5 EE i <
2 = Standard MSP43@ includes ========
5 ADC10_ext_AVee Reference W e
{5 LED Biinking [Active - Debug] Breakpoint (Code Composer Studic) » %
il Includes Unde CileZ o mspd3h
T Revert File U tmew/ms
o e ® main(int, cl
=
(= objs :
& BCSplus inite Open Declaration B3
i pen Type Hierarchy
[€ CSL_initc Open Type Hierarch 4
init.c en Call Hierarc! el Alt+
GPIO Open Call Hierarchy Ctrl+ Alt+H
[€] System_init.c Quick Outline Ctl+0
% L’I;‘:"]‘-Ag-':‘“ Quick Type Hierarchy Cte [t configuration
plus_init.c
) cel i Explore Macro Expansion Ctrle=
& makefile Toggle Source/Header Ctrl+Tab
) makefile.libs Show In Alt+Shift+W b
¢ Inl_msp430g2553.cmd
&) main.c Cut CtrleX
& main.cfg [Grace] Copy CtrleC
B makefile.defs Paste Ctlev
) MSP430G2553 .cxml [Active]
5 msp430g233_adcl0 12 Quick Fix Ctrl+1 -~
g Source AlteShifteS » » <o »
B Console 3T Surround With Alt+Shift+Z b |~ 5 = = O || problems = O || Available Products 5% =0
CDT Build Conso Refactor 4 3 errors, 0 warnings, 0 others Shows modules on the package path of a RTSC
error #10234 X ||| Deseription - project. This view is currently empty because
error #10810 Declarations * Lout” not there is no RTSC Cenfiguration File open.
built . . @ Errors (3 items)
gmake: *** [| @ #10010 errors encountered during lin}
gmake: Targe| ~ SearchTet ' @ #10231-D unresolved symbols remait
v» Compilati{  Team N B unresolved symbol TAQ ISR, first refer
were Buitd Compare With 3 5
Bui F =3
4| m _ » Replace With 3 - ||« [t = r
1l Licensed Preferences... Writable Smartlnsert | 16:13
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/#% Interrupt Function Prototypes */
extern void TAD TSR (void):;

oid TAD ISR (void)

B1OUT ~= BITO;

®f
fpragma vector=TIMERO AQ0 VECTOR
__interropt wvoid TIMEROD A0 ISR HOOK(wvoid)

{
J* Capture Compare BRegister 0 ISE Hook Function MName */
TAD ISR():
/#% Mo change in operating mode on exit */

}

/3. 11 ARG E
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4. MSP430 XM RIRIENH
4.1.MSP430 R4 RFE

7E MSP430 k- gmfErt, Bw WA MH CIB ST K. CCS—/EZEMILRER]

FERE C AR e M L2 AT IR IALERACES, AT SEBLRE P Zh R .

PARTF AR . HA B2 E 0 A% 430 147 C i
T Ay — S48 55 FF i 3ok A2 AR A1 Bl T RE

TREITN 4.

Macro
source
files

C/CHR 528

LR

Macro
library

S

Library of
object
files

py — 1

Xf F 3L H
v _ ——

RN

=]

C/C++ name
demangling
utility

Library-build
utility

Run-time-
support
library

AT

Hex-conversion

utility

EPROM
programmer

Absolute lister

Cross-reference

lister

Object file
utilities

& 4.1 MSP430 i FE K

WE AR A MSP430 (1]
R — AT RRE, HARHS
F P 9 55 (1) CICH+JRARTD Y CIC++4 R 25 2 38 2E i
AT, 2S5 i gn T RAR RO, e RiERR AL T AT X G0k, R AL
FiEAT. gmAERE, X A CICHHRFRIX —ER, BT LATE JG 3CXF CIC++4gm 30 4y 1k

Debugging




4.1.1. C/C++fpi%as
— RV, CICHHE T niF s INRE IS BLENE LR 1SO btk

o ISOFRECIES

CIC++4a a3 TR C il 5 ¥ /i85 C i 5 FrdE ISO/IEC 9889:1990, MM FEFEERER
RGYFEE 5 AT ST €X3.159-1989 ArifE, {AFR C89, Ik M2 3 [ E S AnifE h 2> H
B 48R 1SO At R At 1999 4ERiR, 1HAZ TI AR MIgwiEss (CCS) 1N 1990 i
4k 1999 iR 1SO, X2 A AT R R R 2 B AR R, fEFE R dn it
FE ] RE S H B VA A R IR L o

o ISO HRifE C++

C/C++4mE2R T C++iB 5 M 1E1E C++15 5 FrifE 1SO/IEC14882:1998 ., Z PE#R I S FFIR A
W CHIET, EX LR ER CHRRUR TR, PRI S% slaul32G.

o 1SO FiEMISEIT S

O 1 2 B B A D K SERT IS AT 8 2 . T I PE BREHRAT & o/ CH+hmit. 128 R
W ThREAPRHERI N S, AT RAE, ShANAOR, B, TR, =M
TRESR B AR Xt bR o W45

ANSI. 1SO FrifsE LT C 1R 5 PR32 H AR A B AR R sy SIS AT M B B E LA B2
IR — SR ik TSR )8, R —I)RefE A RS L RfF L — B
C il EP T A SRR L fE

o SEWTIBAT FEXT KAC BEAN 2 7T (B AP e /MR FE IR SCHE . A58 wehar_t 2850
BT SR AR int RADRERAE . TEFRFEA AT char 8, B0 s 73kt
<wchar.h>Hl<wctype.h>, {HIFAZHH A FTA IhEE.

o SERNIEATEALE — Ak f<locale.h>, (HFRIFHANIRAL G/ NFEEE I SCHE, ME—SCHF
G S RS CIEF B

4.2.MSP430 C EZ/AN

4.2.1. HIEARA
MSP430 FIHHE AL E IR o



Range

Type Size Representation  Minimum Maximum

char, signed char 8 bits ASCII -128 -127

unsigned char, bool 8 bits ASCI 0 255

short, signed short 16 bits 2s complement -32768 32767

unsigned short, wchar_t 16 bits Binary 0 65 535

int, signed int 16 bits 2s complement -32768 32767

unsigned int 16 bits Binary 0 65 535

long, signed leng 32 bits 2s complement -2 147 483 648 2147 483 647
unsigned long 32 bits Binary 0 4 294 967 295
long long, signed long long 64 bits 2s complement -9 223 372 036 854 775 808 9223 372 036 854 775 807
unsigned long long 64 bits Binary 0 18 446 744 073 709 551 615
enum 16 bits 2s complement -32 768 32767

float 32 bits IEEE 32-bit 1.175 495e-38 3.40 282 35e+38
double 32 bits IEEE 32-bit 1.175 495e-28 3.40 282 35e+38
long double 32 bits IEEE 32-bit 1.175 495e-38 3.40 282 35e+38
pointers, references, pointer to 16 bits Binary ] 0xFFFF

data members

MSP430X large-data model 20 bits Binary 0 0xFFFFF
pointers, references, pointer to

data members

MSP430 function pointers 16 bits Binary 0 0xFFFF
MSP430X function pointers 20 bits Binary 0 0xFFFFF

4.2.2. TEMA

TEFEF A 7R e A ] — A8 &5, — MR i AZE LN SN B AT R 5 8. 1
PRELNER: 2 BB ZE0E X BLA 3 T A BB ANES . X8, RAE A A B A, 7]
LA S N R R, BASHN R E.



finclude "msp430g2553.h"

int add (int x, int y);

int z = 9; //global yars Z[HEE

void main()

{
int a = 2;
int b = 4; //local vars & init values
z = add(a,b); JAEAEE
while(1)
{
_NOP();
¥
+
int addkint x, int y) | Bz
{
return (x+y);
}

WK PR, AR 2 fEREUMMEEHMTEY], NERAE. 2RAE, B4 EGZEE
R UGRE R T s - RIS RE S, EIRIAT IR R AR = O & SR AR B L
£ CCS BRIAKI emd BCESCHFA, & /RAZE M FCEN AT RAM 5[0 AR -7 B8 B e LY
EJRACE, RMACENIAETRAE R N AR E SO AS R, B PR a Al b, MIe/RAcE
AFENE, e N aegceam R i, B RGERSRHN R E4 AW, [
LB R, 2R MR, HERBITFXOAN, SRR S ER AN, B
WRE. &AM ERAONEASH, BT E L7 R % add, 365 1 AR5 x A
y AIEZ, 1E add T BB AN T 200 x Ay BEAT P A PT DAE AT

4.2.3. REFMERE

e Static FFSAE

FERTSCH IR 2R AL B AR BN AR, AERITRREINT, WAF SRR, AR
WRTFHER, FFRIFREEN R AU FR AR AR R, PUTR BRI 1M static FAAZEAN—
R SR A B M RIAE T, AERIT A, FSRENAAESERE, W N RN R
HEHEH . TEWRSH THEBRET, € add O FRE, SCOREEE a RN, el
Wi 4 AR 2 RNEERE T B ATIROL . P BARBS I Z 57 T 4104 add T ERECH AR R
a B XCNHARA R W R, WER] 2 AR B R . IR D) BRI FEI 45
RPAERERE: £ add WEUS, JREARE a (AR, AN add BE,
HH AR R a, JEHIMIEY 1, TRl z BB RS 20 IR a E OB R R, HIKRH]



add J&, a I(HASN 2, MMERHASARENE L, MWK a MESHEAE, JE KR add &
Hwt, a A PrRHRgIaA TR ERAIME 2, Pt AR 2 MK GE Y .

#include "msp430g2553.h"
int add ();
int z; //global vars

void main()

#include "msp430g2553.h"
int add ():
int z; //global vars

void main()

{
while(1)
{
z = add();
_NOP();
I3
}

?nt add() HapHABEEE

static int a=1;

return (a++);

{
while(1)
{
z = add();
_NoP();
¥
}
int add()
{
int a=1;
return (a++);
}
}
BITER
z=2
z=2:
z=2;

o extern /M &

M ON N
Innn
= L DN

TEARVERFFR UL G OL T, FEREAN SO e LR85 R Be Rl 4 al SO, B A28 e ik
#H JREZE) i, XY TEPOE 2SO, R IE S . 1
extern A5 AR AR AN R SO 2 A4S B 1 A o). 48 B B extern 28, TIAZARSA
ACRT DA 241G SO A A, [RIB a] DA AR A A S s o A . i s, filel
H file2 AR — TAEFRIPANE A, filel HE X T2 z, 1 file2.c FiEIL1EF) extern int
z, 13 filel i) z ZREFIFE W] LALE file2 THEM .



42.4. BEFK

MSP430 e o s AT AN A € 8 5 FR AT IUSRIEL, (2 4E MSP430 4fzs >
ROEHEPERIEEINZALEFAT, JCHRRAEX W A7 Ay BEAT BC B I . 723X BLX X L

filel. e

#include "msp430g2553.h"

int add ();
int z; //global vars

void main()

{

while(1)

{
z = add();
_NOP();

}
}

int add()
{

int a=1;

return (a++);

B AT HEAT TR L) B IR A

o WHEGNIZHIIILEE M, i) NiZE o MiZiE 1, HA@iE 1 TLGRERAE 0
FME. 524 0 MESRERHNEE 0, 52HE 1 MENRFAZ, 5i2H o Mk
FEAAE, 5 1 HEERADY 1. EE BRI 5 E AR 50 I H A WA,

Horp AT RO AR, IR BUE LA RIS S 4R, TP

fileZ. c
#include "msp430g2553.h"

extern int z;

PRAERT i B
&& Y
|l AN
! PR
A

& Y
I AN
A 1B 7B
>> ¥

<< K

SRR B A2 0 FZAE 1 WRl, .

5&8&38

5&8

K0y 5 A1 8 #yiZ 1, B AR [RME B 4R

1, RAVEAE

TALAr BT 518 /F: 0101&1000, 45N

0000




s E 52 M. —BokiiZiEYE (&&) , EHEL (|| AEEAE (1) FEHKEA
HHELECE L, BN if...else...BY while O BRI EL, M #/ELE MSP430
Y FE R H BT B A7 S RO B e B

#include "msp430g2553.h"

void main()

{

f&* e 28 e o0 R 3R e R R SO S o ek ok ek ke e ok e o S o R R R R O R o o R R R R R R R R

* STANDARD BITS

AR A A K O K AR RO O R KR AR R AR R R

#define BITO (8x0001)
P10UT = BITO | BIT1; #define BIT1 (8x0002)
P20UT = BITe; #define BIT2 (@x0004)

P30UT|= BIT@ + BIT1; #define BIT3 (0x0008)

WERBIFE TR, SHEH 10 A% (pxouT) BHTHECE, KRSk ekt
BITO F1 BITL HIJE Lo LB H T =Pkt 2 A2 2 A 1 7575, #80] LASEILX 25 A7 48 11
WAE . 2E—F, @A sEEE, P1OUT #lCE A (0x0001|0x0002) , iX & 16 £
5k, ¥y 2 S, J5 8 f124 00000011, Bl P1OUT ZfEes i /a it E 1, W
A VOK P11 AT PL.O S BN T . SRR R & R B BARIS &40 F
P10UT = 0x0003;

LIRS EARTT LS FIRE I T RE,  H R ARA LU T s E B 5 7=, 5
[ PTEEHERT . 7E MSP430 [ 77 A7 2 il B HH &8 & BN W28 —Fh s I BC & 51,
XM SR AE MSPA30 Zi FE LR HERE I

P20UT|=BITO; Z[F-F* P20UT = P20UT | BITO; F&ATT40E “ |7 #AE AR F AL E, Xk
F0 25 A7 LA — N K Z N TE TR T3 A7 a4 SR IME, 2 e re I
B I RIS AN 5200 2 A7 28 BT PIRAS o B WLAERT LG A0 IR B 0 27 A7 4t 20 AN [ (1) 4]
AR, K2 B 0 T TEANSE FH 1R A 3 T 7 6 2 A7 d A (B AT E O, T B 1
JHEHIGEX AR I FTA AL, ToR 2 R BIRRHEAT I T e S, WX AR
HAWAI A B RE AT TS, TTRESIE A RIEEm, BT LR 04T 27 A7 2 c 2 1 i
R A =M. thah, AR SFRE =M, EF—HoWETRIEFHT
“+7 , HSLTERI [ BITO Al BITL HIEARRIMBUE & UG IR 5 B =Rl “+” HUR
“17 HEEEFTLE .

AL (A RUE WL AT DR PPIRAS 0, thanije LED [NAR, LED [RIRASE
PRI IR A WA e FP B S IOIRES W SR AT U S SO, A R W S ET AR I 2
e XFESL T AT AR R (A) SRSEI:

While(1)

{
PxOUT ~=BITO;
_delay();

}



ZBACHS R SR S I 1 P20 i R FESP R, 24 P1.0 5—> LED AHIE, RISl T
LED [N AR P LB I R T [ 2 4% B A T Tt U0 82 2 e fm) 1) P AR R Bl (A ] B b st
IR INRE, AWK PxOUT A7 2% 8 A4 4R{E A 0100 1110:

HATIREL PxOUT BITO

0 01001110 0000 0001
1 01001111 0000 0001
2 01001110 0000 0001

MR FIRIE R HE B, A3 25 55 80T DR 25 55 5 IR R e AL RS o0
[F) B AN S LA IR S

K (<) L% (>) BAEN 2 A FAUETF .. WX A E N EUE 3
BN

x = x<<n; FEMF x=x*2" £ n iz, MY TR 20 n K7 [FH,

x=x>>n; EM T x=x/2" 5% n AL, ML TBRULL 2 19 n IR07. FENiiE R T8
YEREATHT, AT DAL B EA IR T AT 85, T M F A7 e vT DAREAT — e 3
TR W PG HERAE o



5. CCS MSP430 T 24 HIfHT

£ CCS fd i — & AP Ul 45 CCS it — A TR T N, IX Bt — 45
B MSP430 TRE AR AL E 1 SO R4 AR £ ) A 2 AL P

W FTR, M CCs & LA M) Explorer SRTAE RS TRE, RILLAEF SN 4
M, HEZ TN 1. Includes; 2. Cmd L& S 3. PR 4. Coxml L & S0

4 CCS Edit - TI Resource Explorer ~ Code Composer Studi
File Edit View Navigate Project Run Scripts Window Help

oS- it i g B & B #zcC
[ Project Explorer &3 B % ¥ = O (7 TIResource Explorer &% =0||g
> 25 ADC10_ex1_AVee Reference ~ ||An
. I L£D Blinking Packages: [Al | Devices: [an =] Topics: [an ﬁ/_? -
4 15 msp43002:33 3dcl0 1
4 ) Includes enter search keyword URL:
&
> (18 CiftifeesvS/ces_base/mspd30/include i Welcome
L8 CeftifccsuSftools/compiler/mspd3 finclude 2 controlSUITE ()
Ink_msp430g2113.cmd 5 MSP430ware T’ Resource EXP’OI’GI’
g m5p430927553‘h o A place to browse examples, documentation, and online content.
® ADCI0_ISR{void) : void
© main(void) : void Filters at the top of this window can be use to narrow down the conter
& Time: &luoid) - void h
—_—————— displayed in the left pane.
= el [Active] * "Packages" filter will limit the available content in the left pane to the
currently selected product package item
* "Devices" filter will further narrow the content that is applicable to the
selected device item
* "Topics™ works the same way as the "Devices” filter, it further narrows
the content that is applicable to the selected topic item
The free form filter in the left pane accepts keyword(s), content that m
the keyword(s) will be displayed in the left pane. You can use "*" for w
and "|" to separate more than one keywords. Use the Back and Forvi
button at the top of this window to navigate between last viewed page
El Console 52 o - B = 83 [ Problems 52
No consoles to display at this time. 0 items
Description B Res
n® Licensed 0 items selected
5 — v =t N
5.1 CCS hrifE TAEZH K
5.1.includes

FEZH TS TR WRE RSSO AR T A SR, B oy ccs BN P
ASICHRERAR, 2390009 MSPA30 HISKSCHRT C 18 F ARG ISR AT 4R At 1 AR 25 1)
MSP430 Sk ICIFE SC, BIR R A7 € 30 H RO A5, XER AR 5o 1T B ARG
(K1, X EEIREE AN R 1 G B BT SR BRSSO T RERS AT AR, i DALEASCT- 5 T RO RS A 0 B {6k
TE R RN S B 2R, W EIR SR B e, T A R kS i

AT e TAEA RN B Sk SO e ? 78 TR A, EH “properties” , fEiH
B JE EXT TEAE & FE “Build” = “MSP430 Complier” = “include options” , WK TR,
BWFEINT R, — R m Rk, A—MaEnin— 1 ExX, GEZBE NI A
(RS S AT CAZEAE S b RS I A A B e S AT AH B 44 - 0T DU BBLAE AR I )
include B2 LA A A, B CCS BRINIPIAS LS B8 42



« CCS Edit - TI Resource Explorer - Code
ile Edit View Navigate Project |

(il R~ w type filter text Include Options Gv e w [ %y CCSDebug (B

15 Project Explorer I3 » Resource ==
nera noutline i

=5 ADCI0_exd_AVcc Reference
= LED Blinking
% msp430g2x33_adc10 12 [Activi
) Includes
(15 C:/tifeesvS/ces_base/mspd
(15 C:/ti/cesva/tools/compile
|4 Ink_mspd30g2113.cmd
mspd30g2:33_adcl0_12.c
= mspd30g2553.h

+'+ Properties for msp430g2x33 adci0 12

4 Build Configuration: [Dabug [ Active ] v] [Manage Configurations...|
a MSP430 Compiler
Pracessor Options

| REE
2
gz
=3

dvanced Sptien TESE A0k T
> MSP430 Linker
Debug

fent.

@ ADCL0_ISR(void) : void
® main(void) : void

\fthe conter

|| to the

e to the

#9d dir to Finclude search path (--include_path, -
"${CCS_BASE ROOTY/mspa30/include”
"§{C6_TOOL_ ROOT}/include" 1)
p 5 , |lent that m
ety Bt e e " for w
‘fand Forv
ed page

|[f narrows

] .

I I

K 5.2 cCS TAE Sk SRR 7 v

g Licensed 0 items selected

5.2.Cmd Fc B X4

W Bz~ 8 MSP430G2553 [FERIA emd BB S, %30 B R R4 BE 430 P
FLASH i1 RAM ZS[a], 7E link 2 FE ib 25 R 8 B AT bl (0 TH RN 2= [R) (1) 20 B o SCPFIR)
Faf, 75 MEMORY iX—B, SXHEF SR (MSP430G2553) [FA7-fiti H e WL 34T
FE X, XA AR, ANFEELS IS E FLASH, RAM FIR/NEL A Bt 5¢ R ERAS R AH
[F, FrlF AR S H 430 2006 AFEE emd XHE—m S, AP ASIHZER 1
WA BATIESERME . 5 ANEAE 5425 SECTIONS FE X, TEIX #B 43 32 B2 HFE I 1 P 25 33
AT HhHE A (B A0 B . R MRS FE R S B S A AR (section) , ERUSTREA B E
XHKERHBLL “.7 TPk, Gmi Rt B PR E X RUE M . T B — A SRR R TR
TE S A R AR e A7 bss BY, TEFRIT IR MBS A6 7E cinit B, .stack Bt
FEF A e SRR AR, 1S BT 2R W S AFAETE text B



J AR AR KA A A AR AR AT A KA A EH A AR AA A A A A FAA A A A EFA KA A EFAH KK |
/* SPECIFY THE SYSTEM MEMORY MAP */

j****************************************************************************[

MEMORY
{
SFR : origin = 9x@000, length = 8x0010
PERIPHERALS_8BIT : origin = @x@018, length = Bx@OFO
PERIPHERALS_16BIT : origin = @x@188, length = 8x81e8
RAM : origin = @x82088, length = Ox8288
INFOA : origin = @xleCe, length = @xeede
INFOB : origin = 8x1080, length = @x@e4o
INFOC : origin = @xle4e, length = @x@edo
INFOD : origin = @x1e88, length = @x@e48
FLASH : origin = @xCeB8, length = @x3FEB
INTG@ : origin = @xFFE@, length = OxB882
INTe1 : origin = 8xFFE2, length = @x@@82
INT13 : origin = @xFFFA, length = @x@882
INT14 : origin = @xFFFC, length = Bx8882
RESET : origin = @xFFFE, length = @x@@82
}
j****************************************************************************j
/* SPECIFY THE SECTIONS ALLOCATION INTO MEMORY *f

j****************************************************************************I

SECTIONS

{
.bss : {} > RAM /* GLOBAL & STATIC VARS */
.sysmem  : {} > FLASH /* DYNAMIC MEMORY ALLOCATION AREA  */
.stack : {} > RAM (HIGH) /* SOFTWARE SYSTEM STACK xf
. text : {} > FLASH /* CODE x/
.cinit : {} > FLASH /* INITIALIZATION TABLES xf
.const : {} > FLASH /* CONSTANT DATA *f
.cio : {} > FLASH /* C 1/0 BUFFER xf
.pinit : {} > FLASH /* C++ CONSTRUCTOR TABLES =/
.infol : {} > INFOA /* MSPA3@ INFO FLASH MEMORY SEGMENTS */
.infoB : {} > INFOB
.infoC : {} > INFOC
.infoD : {} > INFOD
.intee  : {} > INTe® /* MSPA3@ INTERRUPT VECTORS *xf
.ntel  : {} > INTel
.int13 : {} > INT13
.intld  : {} > INT14
.reset : {} > RESET /* MSPA3@ RESET VECTOR x/

}

/****************************************************************************[

/* INCLUDE PERIPHERALS MEMORY MAP */

f****************************************************************************f

-1 msp43@g2553.cmd



SR | INt X 4= 200 | Al
Cbss) |L.nt y i=i 7; Ceinit)
void main (void)

{
JRy AR Tong z;
(.stack) R -
FZEXFY |, ey
) - (.text)

K 5.3 R M RAF ik BL

MSP430 ({47t 75 (A4 FLASH F11 RAM P,  ELAA bR i A ot 30 ) 25 B an ] 76 N 47
Z A AT A EAE emd SCHEHECE . Bl 7E B K emd SCEEH
.bss : {} > RAM /* GLOBAL & STATIC VARS */
PR O R ) SR D RE: BRI R ARG A R AR EE SR E, B bss B,
RAEE RAM 1, [AIRETEREAT 430 RAERT, %3R4 WATERZEUE L N AT BT8540,
(EEN, TR AT & ride F 75 2844 () RAM AT FLASH 4510], A5 I 4w % £ U emd S
PEARRIEE R, HIRZ RN e L B2 e E P R BN REE T RAM JEE, Al
DATE G B2 B 0 P9 A7 23 [ ) 2 HER — @ % 18, L —28 RAM ZRIFRIAS . i,
FATH MSP430G2 R FHEAT fil LCD HIEIEEoR, ZRA KR == [k T AR 2 =
A4, FRAT— M2 o SN const &, IR I 5B e3P B 2 I . const BYFR A1 11
A E RS ES R, RN emd FLE SCHH &I, .const BUZERINTE M) FLASH 73 [A] ],
I FLASH 25 [0 — M L RR 0 . an SRR T AR e I, AR HEAE RAM 2] [ B,
TE 4 PERT 1T B 2> H B RN .

7E cmd ST LU ERR K NIEAT 7 X

-C
-stack 0x0100
-heap 0x0100

R iEA)E LT stack K/NN 0x100, heap K/NA 0x100. S HERR K/NAT € AT BATE
CCS W B it AT X, FTFF LRER B X URAE, 7F MSP430 Linker [ Basic Options 114
X RGEHERR KNI S FEAE FH 30 75 B AL | AR TR AR 3 AR B B HEAR /N 88T
AT E X, BN sprintf()i&a) .



S Properties for MSP-EXP430F5529 User Experience

type filter text

Resource

General

Build

M5P430 Compiler
Basic Options
Language Options
Language Options: MISRA Ru
Parser Preprocessing Options
Predefined Symbols
Include Options
Diagnostic Optiens
Runtime Medel Options
Optimizations
Entry/Exit Hook Options
Library Function Assumption
Assembler Options
File Type Specifier
Directory Specifier
Default File Extensions
Command Files

M5P430 Linker
Basic Options

Command File Preprgcessinh

Diagnastics
File Search Path
Linker Qutput
Symbol Management
Runtime Envirenment
Miscellaneous

Debug

4 1 |

@

Show advanced settings

Basic Options

Coenfiguration: [ Debug [ Active]

'] [ Manage Conflguratmns...]

Specify output file name (--output_file, -0}
Input and output sections listed into <file> (--map_file, -m)
Set C system stack size (--stack_size, -stack)
Heap size for C/C++ dynamic memory allocation (--heap_size, -

Link in hardware version of RTS mpy routine (--use_hw_mpy)

Browse...

OWSE...

"MSP-EXP430F5529UserExperience.out”

P430F5529UserExperience.map”
200 |
160

Cancel

T

5.3. 5 304

5.4 HERR 2 RME L

TR EAM LR “add files...” , W RAA AR ANINSCAF, AHEIRICF. JROCIF
RAITTLLR ¢ SCIF AT DUREVE G SR o By SCPRRT 0 = T g on] UG 220 s
skt ERARRMEE. KT T BIRER SRS FE 5 SR A TR A 4 .



'+ CCS Edit - Tl Resource Explorer -

File Edit View MNavigate Project Run Scripts Window Help
i @ - e A B L= -

[ Project Explorer £2 ] F & ¥ = O||@ TIResource Explorer 53 ]
> 2% ADC10_ex]_AVcc Reference
1 (& LED Blinking Packages: [AI-I- v] Devices: [AI.I.
4 [ msp430g2x33_adc10_12 [Active - Debug] keyword URL:
4 ) Includes New v
b (8 Ctiveesy come e —
b (B Ctifees] B2 Copy Ctrl+C  trolSUITE @ Tl R es
| g Ink_mspd30g Paste Ctrl+V  P430ware
4 [€ mspd309233 3¢ Delete Delete
ey Soue O R oo
@ ADCLO_ISI
o mantve :{Amm 6 Filters at the top of th
B ;S:;;:ﬁ Sname displayed in the left p
£ Import.. + "Packages"” filte
3 Bport.. currently selecte
* "Devices" filter
Show Build Settings... selected device
Build Project + "Topics” works
TomBm=s: et thfe com;.-;t that
e & the keywordi(s) wil b
Sl=alingEd and "" to separate m
Build Configurations » button at the top of th
Make Targets 3
Index 3 I A E-r5-=0
< Add Files... hgulay at this time.
P—, erus As _A-/
Team 3
Compare With 3
Restore frem Local History..,
Source »
Refactor »
7 Licensed Properties Alt+Enter

K 5.5 PESCAFER I

5.4.ccxml BC B 4

WE B~ B AR B SO, RSO s T X e R B AR e AT E . — iz
ol TRER B3, HA Ko WA E TN Oe# T TIE, O
(P, IERAR RS,



B =TT =N 4 T % CCS Debug

() TI Resource Explorer | [£] *msp43092:33_adcl0_12.c W =8

Basic
] General Setup Advanced Setup
This section describes the general configuration about the target.
i
| Connection [Ti MSP430 USBL [Default] v] Target Configuration: lists the configuration options for the target.
Board or Device i
type filter text Save Configuration
MSP430FW425 o
MSP430FW42T [save]
MSP430FW428
MSPA20FWA29 Test Connection .
MSP430G2001 To te.;t a cgnngdlon, aH. changes must have been ;a\{ed, the
configuration file contains no errors and the connection type support:
MSP430G2101 function.

M5P430G2102

MSP43062111 Test Connection

M5P430G2112 [
MSP430G2113

M5P4305G2121 ¥z
M5P430G2113 -

Mote: Support for more devices may be available from the update manager.

<] 1 o

Basic | Advanced | Source |

o
o= Ou..
An outline
available,

[B concale 52 | o B~ v = B[F problems 52 |

5.6 it & 1

WIERAE TARE AN 2SR B aE R, P R n] DA B i e G — > H i &
A, kSR “file” > “new” > “target configuration file” FT AL B A, H A AL R

MORAFERAR o



S;*s. CCS Edit - msp4309@3_adclﬂ_m062113m1ﬂ - Code Composer 5

Edit View Mavigate Project Run Scripts Window Help

MNew Alt+Shift+N » | 0§ CCS Project
Open File... % Project. —
. . FOGZL‘B.C(
Close Ctrl+W | |¢] SourceFile
Close All Ctrl+Shift+W IET Header File
Save Ctrl+5 5 e
+ | o
H Save As... -é__fl_l.e—ﬁo—m Temulate ———-—.___-“
@ SaveAl Ctrl+Shj Folder h
Revert 2] Target Configuraticn File
. &2 (C6Flo Diagram i
ove.. - S
TEE - BSAAIOS i Confiauiation Ela———""
fename... 2 |[& RTSC Configuration File
Refresh F5
o
Convert Line Delimiters To 3 D i
[T TISPE3UG200T
Print... Ctrl+P [] MSP430G2101
. [] MSP430G2102
Switch Workspace 3
[[] MSP430G2111
Restart
[T] MSP430G2112 |
fiy Import. MSP430G2113
&5 Export.. D M5P430G2121 7
MSP430G2113 -
Properties Alt+Enter
1 M5P43062113 . cooml [mspd30g92:33_adcl...]
2 mspd30g2x33_adcl0_12.c [mspd30gda3...] hd
3 TI Rescurce Explorer more devices may be available from the update manager.
4 CSL_init.c [LED Blinking/src/csl]
Exit
’ T
Basic| Advanced | Source|
& Console &2 l = B~ % -
Mo consoles to display at this time.
[ m 3
o* Licensed

K] 5.7 i B

EFEERZ )G, ¥ “view” © “target configuration” A& & M lc & 1k, &l
FfT7R7E target configuration A28 TUH G 2 — > user defined SCfF, THESHF HE X
(1) B ARBCE S B L B SRR S T IF,  IXRE 7 o DA T SORIR L, 2535 o

i “save” FZEEIRAFACE -



¥v CCS Edit - C\Users\a0220279\6\CCS TargetCor s\NewTarg: Studi o iEe

File Edit [View] Navigate Project Run Scripts Window Help

£4 « [ (@) TIResource Explorer 5 th v I % CCS Debug @»
(£ Project [[5 Project Explorer “mspdI0g2a3_adcl.. | (& MSP4N0GZI3.coml | (2] NewTargetConfigur.. £3 | ™1 = B §= outline| & Target Configurations 52 | =
5
5 AD BE  Outline ) %| & B
& LEL[£i  Problems Basic fil = - ]
s e filter text
£ ™S & Console General Setup Advanced Setup frr
= This section describes the general configuration about the target, = Projects
User Defined
Connection [TJ MSP430 USBL [Default] v] Target Configuration: lists the ¢ & ser Define
[ Target Configurations 7 &) F2806.coml
Scrpting Console A Beard orDevice type fikerten — & MewTargetConfigurstion.cexml
Db [7] MAVRK_F5438A =
@  Memory Browser CELNE1Z -
e [F] CC430F5125
3 Regsters 1 o e
&4 Expressions [ ceasrsias To test a connection, all change.
)| 00s Variables configuration file contains no et
[ CC430F5137 function,
% Breakpoints [7] ccaz0rs143
otber. = Test Connection
] CCa30F5147
] Cca30F6125
] CC430F6126 sl
CC430F5123 -
Note: Support for more devices may be available from the update manager.
< I J * || Click the New button to create a new target configuration
Basic | Advanced | Source file. Click here to hide this message.
& Console % | < B - 09~ = 0| Problems 52 =g
Mo cansoles to display st this time. 0 items
Descrintion ’ Resource
g i ' < i ]
iid Licensed

K 5.8 &AL E A

PLESERE T BAREC B SO 2 AR, N ORTFEM— A e, £ EH
FIEC & SO B AT PLE RPN LD “set as default” A1 “link file to project” , X/
BTG AT DA SR E SO R A, BT R A RS DL T EOR S A B, TS
AT DK% H AR E S SR e 1 TR ER: . P i DU 3 S bR 1 75 SR IE B A 1E 1 5 =K.



elomposerstudio g - NN TN SSSSSSSS———

| = | e

[ %5 CCSDebug (B~

33_adcl0 12.c NewTargetConfiguration.coxml &2 l = O || 5= Outline i =8
=
g I
¢8|
e filter text
Advanced Setup |typ |
-ation about the target. b = Projects
l Taraet Confi tion: lists th 4 = User Defined
] — arget Configuration: lists the ¢ 9 F2806.coxml
= E 1
Save Configuration [#  Mew Target Configuration
o Import Target Configuration
D | Sa\rel
M Delete Delete
Test Connection Rename F2
To test a connection, all change 4 Refresh F5
configuration file contains no er
function, % Launch Selected Configuration
| Test Connection | T Set as Default
ADC10_exd_AVcc_Reference \ Link File Te Project 3
LED Blinking Properties Alt+Enter
= mspd30g2x33_adcl0_12

-ailable from the update manager.

b | Click the New button to create a new target configuration
file. Click here to hide this message.

= El - £~ = O||[El Problems 2 ¥ =08
0 items
Descrintion = Resource Path
4 I 3

P 5.9 fit B SCAFILAC



6. H.% MSP430 HIFEEH

WIHT SO, 34T MSP430 JF & s FIBIAE AT LIS TI B I R 21, 430Ware &
HIKMIE R TR O RBATEATR RS I E TR AT —A 4 Eh T, 48
PR AL MSP430 FIFEAE T 554, BN S (1) MSPA30 AR AT LA J7 (i HhR 21 AH M. 1) 7 41
FEIF, RIS 1) MSPA30 SR X AN MR AN [ Zh R 43 A AH S IR I FE /7 o b 4h,
PPN A AR BE R N B RR P S5 MTE T T, AT AT B P T M I RE I N 2%, 34T PRuide i A
FTF R o AEAS BT X4 A B SR A SRS MSPA30, St T launchpad IR 45 # E
AT ARV

T R BIRE AR — A ek, RIVRARRS (sro) , %IRETSC ces Brd THE, WinyRiRRs i 75
AN SR B BIRE A AT . AR — B/ FH XA ¢ STIFRI4S5H .
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*

* MSP-EXP43@G2-LaunchPad User Experience Application

*

* 1. Device starts up in LPM3 + blinking LED to indicate device is alive

* + Upon first button press, device transitions to application mode

* 2. Application Mode

* + Continuously sample ADC Temp Sensor channel, compare result against

* initial value

* + Set PWM based on measured ADC offset: Red LED for positive offset,
Green

* LED for negative offset

* + Transmit temperature value via TimerA UART to PC

* + Button Press --»> Calibrate using current temperature

* Send character '°' via UART, notifying PC

*

* Texas Instruments, Inc. BERiLHEIS

sk sk 5k K ok oK ok ok sk oK Sk 3k ok sk ok ok oK SR K R oK 3K ok K oK R 3R Sk ok ok K oK K oK Sk ok 3k ok K sk ok sk sk ok sk oK o o Sk ok ok SR ok ok ok K sk K Kk KoK K ok

#include "msp43©g2231.h" ER g 51
#define LED1 BITe TN
wHEEX
unsigned char applicationMode = APP_STANDBY_MODE;
e
void Initializeleds(void);
TERHEEH
void main(void)
{
- FHRBCEX
b
void PreApplicationMode(void)
{
; TEREEX
#pragma vector=TIMERAG_VECTOR
__interrupt void Timer_A (void)
{
} TR S TEFE X

6. 1.7~ F2 VLR U B

Mk, — A —BOEBRSCF Ui, A RERA TS 2GR By, HSbr BiX
BOC PR AR 2 T R 1B AR B R 7 s i I s (T B RRBUS BARR AN o i B Frs 1 a2
Launchpad ] User experience application 2, EBIFEFF 46— BOSCERAFR T S )
DIRefs 7 iEmMHA, AR S T AR A DI I R A . BT, AR



CUKBUE R B A H e A led S INKR, 244 AR ESG s R #E AR RS, RERIREE, *F
TR BEAR A AT R IN,  [R) B K B2 SR TimerA UART f£41 %2 PC. [FIRS, FRATEZEHH
release MIARASE S, ANFERAMANESEIE, XA BATEMFE P 1RAFHEB.

f‘l******************************************************************************

2 MSP-EXP438G2-LaunchPad User Experience Application

3

4 * 1. Device starts up in LPM3 + blinking LED to indicate dewvice is alive

5 + Upon first button press, device transitions to application mode

6 * 2. Application Mode

7 + Continuously sample ADC Temp Sensor channel, compare result against

g initial value

g + Set PWM based on measured ADC offset: Red LED for positive offset, Green
La * LED for negative offset

[ + Transmit temperature wvalue via TimerA UART to PC

L2 - + Button Press --» Calibrate using current temperature

L3 - send character '®' wia UART, notifying PC

14 -

LS * Changes:

l6 * 1.1 + LED1 & LED2 labels changed so that Green LED(LED2) indicates sampled
L7 * temperature colder than calibrated temperature and vice versa

s with Red LED (LED1).

L9 + Turn off peripheral function of TXD after transmitting byte to

| c eliminate the extra glitch at the end of UART transmission

1 * 1.8 Initial Release Version

12 *

23 * Texa; Instruments, Inc.

PP e e e e oo ke o o e o ko o e ko ke koo o o ke o o e o ko o ok ok ko

%%,W%EA%ﬁmH%?Mi?ﬁ%,ﬁ*ﬂ%ﬁﬁ%ﬁﬂo%%A%ﬁﬁ%%
SRS, (EIXBIRATRR T T AR B cPU BLEAME I — AL B (S B2 4h, B RIA —
MERE (EFEREFTR) , 1%H %humﬁ&M*Wﬁﬁﬁmé%ww,E#%%L%@
BEESR . W B s IR Th e A TR A G2xx3 f USCI_AO szl 3 £k SP1 i@, AHL
YERNE®RS, IBATEREME L, SPIRTIALETR, s, N BhE 0z KR E BT,
AR P L ¥ & B LED [#R4E , Hi% LED 25 P1.0 A



2//  MSP438G2xx3 Demo - USCI_AB, SPI 3-Wire Master Incremented Data

4// Description: SPI master talks to 5PI slave using 3-wire mode. Incrementing
5// data is sent by the master starting at 8x@l. Received data is expected to
6// be same as the previous transmission. USCI RX ISR is used to handle

74/ communication with the CPU, normally in LPM@. If high, Pl.@ indicates

8 // walid data reception.

= ACLK = n/a, MCLK = SMCLK = DCO ~1.2MHz, BRCLK = SMCLK/2

L@/

L1 // Use with SPI Slawve Data Echo code example. If slave is in debug mode, P3.6
L2 // slave reset signal conflicts with slave's JITAG; to work around, use IAR's
L3 // "Release JTAG on Go" on slave device. If breakpoints are set in

l4// slave RX ISR, master must stopped also to avoid gverrunning slave

s // RXBUF .

7K/ M5P438G2xx3

PL1.2|-> Data Out (UCA®SIMO)

v/ |

7F/ slave reset <-|PL.5 PL.4|-> Serial Clock Out (UCABCLK)

8
1
2
3
4
s/ LED <-|Pl.@ PL.1|<- Data In (UCABSO0MI)
6
8
9
1

f? D. Rang
//  Texas Instruments Inc.
2/ February 2811
334/ Built with CCS Version 4.2.8 and IAR Embedded Workbench Versicn: 5.18
JA R AR RS SRR AR E RS RRRERRRRERE

AU AT L, S BIRETT AR R SR B 1, FRATTAT BLIG R B SR AT AR AR 5 S B
Diae — AN EI 1 g, AT IXBARISE T HIE AR, 0] DURE AR 1 2%ty
EHEAT Vb . BbAh, TSN T R ERAE B AR 1IE R B SR B 2K, FE R ARAT]
FRINIEAT R BIRE R, SEILEE Y DiRe

6.2. 7 B K30
7R IEAARTDHOFF S A AR/ F T3 6

i#include “msp438g2553.h"|

-

XBAEA) R B 7z SO S R 0 S0 o DA B B T DA SR o Sk ST A 4 K
%, ISR A ILARUEL ISk ST, Bl ces R AL SR SRSk oo, RIX
[1)"msp430g2553.h", FUII R &R EHEAE K math.h”, —fE CIEAR; &F
— Rl HE ). 1E CCS 1, B0 Y 430 FHOC LA JARAE C SkSCHRAE B
TR 4 B3l InfE LR, AR LALE Project Explorer H1 L2 H 3¢ R Includes H %
R EIE SIS Hak, Hib BN 430 BEEARSCHI S CtE, FOTRIONE C ket
FEIX BLA] Dhd o o i 07 SRR BIA RISk S0, FT A BN A AT B R, (HidfE, A%
B HATIE M.



ER A LD T S L Y50 A N T LS R U LIS S )

File Edit View Mavigate Project Run  Scripts  Window
Sk it i@y i@ iv e
[ Project Explorer &2 E|v =8

s

T=F msp430g20a_uscial_spi_09
:.;'3- M5P-EXP430G2-Launchpad
9::;?' Binaries
mi Includes
= CftifcesvS/cos_base/mspd30/include
1/ti/ cosvS/tools/compiler/mspd 30, e
= Debug
| & Ink_msp430g2231.cmd
Ei‘"'; main.c
|=| macros.ini_initial
|7 MSP430G2231.caxml [Active]

K 6.1 cCS HERIN AL & Sk R 1%

T 430 AH G IR Sk S BLTH AL 55 (R 8 2 MSPA30 (177 A7 o AR I8 Lo TR IX 26 5E
SCo AEXS 430 WAFARRCEN, AT EH R ERAAARNALE, TR Sk R E ST
BEPEBR A ST HATRE P IOBCE, Xt 4 430 ISR KRR S KBS 2 130T
W . KRTRXISEIGE A ERIN . PO 430 HZa IR AR B H SR XF CPU R
BHNR A AL AR NI E, PrCAEBATREAT 430 A, LB AR TS — € EA I & 1
IIAHER . BEAh, ARG B S SO E SCASRARF, - Biltn ccs AT IAR Sk SO
AL VRRE A, (H AR A A A2 85 8 SCUMSAT 22550, SR Il 2 B0 20 19 8 11 1 i
JIT CAE AN [F) G B IA B L 3EAT R 3 (10 R AL P — g B X A 1) il



Ly~ -y T HF T T [ 4 -

[ Project Explorer 23 = V = O || msp430g2553.h 52
» [ msp430g2453.h - 1/
. [€] msp430g2513.cmd 2
. [H msp430g2513.h -
» [ msp430g2533.cmd 5
> [B] msp430g2532.h 6* This file supports assembler and C development for
=1

* Standard register and bit definitions for the Texas Instruments
4 * M5P43@ microcontroller.

> €] msp430g2553.cmd 7 * MSP438G2553 devices.
- | [n] msp430g2553.h
> [€] msp4301092.cmd
B mspd201092.h 11 % Rev. 1.8, Setup
» €] msp430pl12.cmd 12 *

> [B] msp430pll2.h

+ €] msp430p313.cmd 14
@ mspd20p3L3.h 15 #ifndef _ MSP438G2553

@ 430p315 d 16 #define _ MSP43@G2553
> mspd30p315.cm -

9* Texas Instruments, Version 1.8

> @ msp430p315.h 18 #define _ MSP43@ _HEADER_VERSION__ 1862
+ [€] msp430p315s.cmd 19
» [W] msp430p3L5s.h 26 #ifdef _ cplusplus

21 extern "C" {
22 #endif

23

> [€] msp430p325.cmd

> [ msp430p325.h

» [i€] msp430p337.cmd

> [ msp430p337.h

+ €] msp430x09x.cmd

» [ msp430x09x.h

» €] msp430x11x.cmd
™ amm a4 '

K 6.2 Sk
6.3.FEE X, TEHHKREFEH
63.1. EEENX
16 C A AT LhsE L —Seh &, {4 FH 7 #define” 4758 o 7ELL R JURME T o] LLdEAT
W B U g S AR B N i 2 T8 e
o STEMEIERAN

#define LEDL BITE
#define LED2 BITG
#define LED DIR P1DIR
#define LED _QUT P1OUT

LHEEAR], T LEDL A1 LED2, 7EMR L4915 P1.0 Al P1.6 A%, MR4EAE1FIEREN
WMEMEE . PR &% 5 LEDL AT LED2 [¥) 10 U I fic & 7] AM# FH LED1, LED2,
LED_DIR Il LED_OUT. IXAEA—J7 HII5E 7 A2 fnl et (Wi fE A PIDIR, P1OUT 7E#%
7 B I AR AN RETE R B AN 10 HIThER) 5 U5, SEERER R AU, L
W LEDL ANFAT P1.0 AHIE, TR PL.2 #HIE, H PR EMAMESUNASURTEZ ALK e X
s, Rl”#define LEDL BIT2”EPT], 7E /= I (1 EL A4 B& b G 75 AT o028, ROKIER T
R E e sh A R I FE P ) TAE S, 48R, ¥ RAR b pomdi ka1 e SCHee, F Pl bl
H e XAk, Ul board_hardware.h, fEiX B HBATIREHE EXE XL, RJGIE C X
PR AR XA SO S E 2T B T

o HMPBAENFE



#define TIMER_PkM_MODE a

#define TIMER_UART_MODE 1
#define TIMER_PWM_PERIOD 288
#define TIMER_PWM_OFFSET 28
#define TEMP_SAME a
#define TEMP_HOT 1
#define TEMP_COLD 2
#define TEMP_THRESHOLD 5

ZHEB AL C AR 4. FEEAT O AR IR P AEAE S SR [ e (0 &
R AR Z AR R HBEAT RE SC, RIRE AR S b 3G 9 7 RE PP RT3, X RERE B it
UL TR i, GnREEE AR T RE A o, nTRIETTAR " #define PI 3.14”7, IXFEAERE
Ferb QR R o, AT DA PUARES, RS R FEHEAT IR, , A T1E define L%t 3.14
BEAT BRI

6.3.2. TEFH

STEFER B AS &, e TR E S . R T I AR B AT R R — N L
B gmAE I, nT O XN R PR R AR AE .. MR WS, EFE CIEE I
TR Z A, NIRRT, HAAR S DR RE A XN R FEIX BB AT LUK 7 B
4% B B AT IR A R 1

unsigned char tempMode;
unsigned char calibrateUpdate = 8;

6.3.3. ER¥EH

G FHREMAEE. 8 FRENEFBS L —Ruska A akm R —Ff2
FGIXFELE main BRELZ BT Jext TR BT A B, BRI @ SUUAE main BRELZ J5; I6FH —Ff
U K 5 VA P PR A B RS AR BT IR . B T, XS AR I,
2 RIS o

wvoid Initializeleds(void);
void InitializeButton(wvoid);
void PreApplicationMode(void);

6.4. ERHE X

1E Bk BAE L e EmE, BN, B TRELIHH R gefa —1
main B (JE: 7E cesvs Y, TR bR E e TR G B B8 i — > main.c 3T,
FERWRZE B O FABE ST XA B 3 B SCHE R o 78 MSP430 gz il ds dm A,
main BRI E S T AR B RN AN, FEIF B AT IR DL BB R T E S
AbBE (AR 2 IHEIX 7 2 TRAE W IR S A2 TR 52O .

W B FTR —A BUB R ) main B AU R
o JRfAREEE W



FEIFAR R AR B — S E R Boh I BIR0AR B,  Re BE R IR A R P A ] A — oy
AR, Wz .

o DifetEAUE

YERRBRER, — RIS A RIAE TN —fER) . SRR A T E
I} 28 D RE I TE AR IniZiE A o

BN RSN IPIIA TR R . X EEHTIRAL T AR LLELSAE main BRECH S, ]
PACL7 R K P 5 RS0l 38 R a e s i b %, w] DM T 1 R i) Oy s 2R
B5, WRYLA LR, il X FFxE A 10 3 DT E RS, W LLEEES A main
BRELIIIT AR . IRHTA AL I ARG 2 RO RE PP B2 (12 A% ST 5 AT AN R, B b i g A
PRAE T RERIANTE, % LED FHZEE S AT WG 1L o

AR AL EEFE 2 HILTE main &P . AR EREH 2RI —A Loop fE3F, 1
PEIR kAL FE BSHE AR ThFERL R, (i Main Application Loop FiR) o X & —ANELic it
T 430 fRIhEESES 7, XATEAMEVIG G, AT REAS A NS SEEL, ATk %
Bt NFHRL R FEREE,  SEIE MSP430

void main(veoid)

{
unsigned int uartUpdateTimer = UART UPDATE INTERVAL; 2 =
unsigned char i; E%&EE%
[WDTCTL - WDTPW + WDTHOLD; KA1 |
InitializeClocks();
InitializeButton(); '&%mﬁﬁ‘f‘t

Initializeleds();
Freﬁpphcatlonﬁnaei i;

HoAtn 4b 2R

/* Main Application Loop */
while(1)
{

:_bis_SR_register{CPUOFF + GIE); f// LPMB with interrupts enabled
}

}
»

6.5. T B HUE X

A2 2 SR 5 7T DO 22 R B G BR U AT 2 S, T IR AR 5 7R e AR AT
5E X o



void PreApplicationMode (void)

{

) TEREE XL

#pragma vector=TIMERAO® VECTOR
__interrupt void Timer_A (void)

{
- RS TR

B PR N IR R 35 TREFP IO K 75 B B SR P I A AR, X2 7E 430
SRS S g S AEAE R RO AT BLE 228 S b i B g (s BERRAES %
BIRERES; PR, HPIRYE R B DhRE T R I B L LR IRE A
.

HWT R, SRS E B ek S

e ——
<’§pragma vector=WDT VECTOR
interru oid WDT_ISR(void)e— );HF, E %SLE‘JE&%E%
{
|. TIE1 &= ~WDTIE; ]// disable interrupt
; IFGl &= ~WDTIFG; *// clear interrupt flag
. WDTCTL = WDTPW + WDTHOLD; .// put WDT back in hold state
! BUTTON_IE |= BUTTON; !/ / Debouncing complete
b e e e e e s e e I
A8
T IR 55 TR T

K 6.3 S 7 iR 55 5 Ry ALK



M3 A

FF RS20
FIIFH 52 B 28 7F Launchpad _E 528 525 EE R 50% 7 PWM S RGHTH, BRI 1s.

1. 1E ccS H4TITF 430Ware, 3| Launchpad F1f MSP430 #l5——G2 A H 1 IE
LA EAE T, BRI KRS R,

A & - fe=1n 4 -
=R =S| (T)TIResource Explorer 3 [ mspd30g2:33_adcll 12.c [ mspd30g2ed_ta 17.c

'cc_Reference

sterPack_UserExperier Packages: ’MSP-’lBUware v] Devices: [AII > | Topics All
de10 06 enter search keyword URL: www ti.com/general/docs/lit/getliterature tsp?baseliteratureMumber=sl
adcl0_ 2
adcl0.12 oF Devices
ta 17 & MSP430F 1

& MSP430F200
& MSP430G2Dx
| User's Guide
@ Datasheets
@ Erratasheets
@ Code Examples
(3 Grace Examples
&F MSP430Fd0
&F MSP430F50600
& MSP430FRxx
F CC430F00
& MSP430L092
'.' Development Tools
¥ Libraries

K A.1430Ware & F 7 45 AU T

2. AT LRI 2 FORE RS AR PWM . GBI X MSP4A30 &R 25 ST A T M,
RIK F e I g A b my U R i Pt SR B &5 2 LU AT 1) PWM SR T RO 3

3. 1F 430Ware TR BN WK TR IRPIFER . (ET e i 2 iib & 151 7 234100
FhFIH TimerA £ PWM FARAS

4. FRYELIR T RIEFE RGN — RIS, EA TR TA 3 17 MR,
EAZBIFEF, e 28 TAELE UP 80T, RSN 32KHz SRAE I .



S it s sapror s s

File Edit View MNavigate Project Run Scripts Window Help

- cidsr P i@ i G [ % CCSDebug [

&5 project Bx... 52 | =[5 () T1 Resource Explorer &3 | (6] mspi309233_adc10_12.c | ==

8%~ A £ &

— || Packages: MsP430ware = | Devices: |All ~| Topics: Al 4 =
(5 ADCLO_ed_AVc R ges: | J [ P oD
L CapTouchBoosterPi | [cnter search keyword URL: -
& LED Hlinking & Devices Enepdi0z2sed ta 03.c - Timer &, Toggle P10, Overflow ISR, DCD SHCLK B

5 msp430g2:33_adcll
@ & MSPA30FLe
5 msp430g2:33_adcll @ Veriia
& MSPA20G2
) User's Guide
&4 Datashests
&4 Eratashests
% Code Ezmples
@ MSP43062:01
@ MsP43062a1
@ MsP43062Q1
@ MsP4306231
@ MSP43062:02
@ MSP42062:d2
@ MSP42062:32
@ MSP43062x52

Toggle P1.0, Overflow ISR, 3ZkHz ACLE
Toggle P1.0, CCRO Up Wode TSR, 32kHz ACLE
Togzle P1.0, CCRL Cont. Mode ISR, DCO SHCLE
Togzle P1.0-2, Cont. Mode ISR, DCO SHCLE
Toggle P1.0-2, Cont. Mode TSR, 3%kHz ACLE
Toggle P1.1/TA0, Up Mode, DOO SHCLK
Toggle P1.1/TAU, Up Mode, 32kHz ACLE
Tozzle P1.1/TAO, Up/Down Mode. DCO SMCLE
Toggle P1.1/TAQ, Up/Down Mode, 32kHz ACLE
PN TA1-2, Up Mods, DCO SNCLE

PHN_TA1, Up Node, 52kHz ACLE

PWIL TAL, Up/Down Mode, DCO SHCLE

PWIL TAl, Up/Down Mode, 32kHz ACLE

Emspd30e2xx3 ta 04. c - Timer

s

Enspd30glxxd_ta_05.
Emspd30zZzz3 ta 06,

Erapd30a2xxs_ta 07

Emepd30s2ax3_ta 08. ¢ - Timer
s

c

-

<

<

<

-
Enepd30a2xx3 ta 10.¢ - Timer
= <

<

-

<

<

<

-

— Timer,
= Timer
= Timer

emspd30gZxxd _ta 1l. ¢ — Timer
Emspd30z2xxd ta 13, ¢ — Timer
Emspd30e2xx3 ta 14. ¢ - Timer
Emspd30g2rx3_ta_16.
Emspd30e2rx3_ta_1T.
Emspd30zZzz3 1a 18,
Smspd30e2rx3_ta 20.

— Timer,

— Timer,

= Timer
- Timer

i el o e e e o e i

,

430 . 3400 T Ul tmmLoosi R ART 2000 B b3Sk bCLE
@ wispec2i03 + Grepd30a2xx3_ta_uart9600. ¢ - Timer A, UltraLow Per Full-duplex UART 9600, 32kHz
@ MsP430G2:43 WOLE
@ MsP430G2:33 o P
@ MsP4306253 . limsp430 2xx3 uscial irda 01.c — USCI AQ IrDA External Loopback Test, 8MHz SHCLE
G Grace Examples * Snzpd30alsed uscia0 irds 02.¢ - USCI A0 IrDA Monitor, MHz SHCLK
& MSPA30Fdc + Emspd30e2xx3 uscial_irda 03.c - USCI A0 IrD& Physical Layer Comm SHHz SHCLE
& MSPA30FSxboc o Emspd30e2rx3_uscial_spi_09.c — USCI_40, SPI 3-Hire Master Incremented Data
& MSPA30FRax o Emspd30z2xx3_uscial_spi_10.c — USCI_A0, SPI 3-Hire Slave Data Echo
& CC430Fox o Emepd30zZex3 uscial uart 01 115k « — USCI 40, 115200 UART Echo ISR, DCO SHCLK
& MSP430L092 + Bmspd30e2xx3 uscial uart 01 116k lpm c - USCI 40, 115200 UART Echo ISR, DCO
¥ Development Tools SNCLE, LFd
1 Libreries o Bnspd30g2rx3 uscial uart 01 13200.c - USCI 40, 19200 UART Echo ISR, DCO SHCLK 2
]
S [~ N ] ([T = =Ml

LYW N E N NS

5. SANLREZE, T X, TEFERER O AHZGIFEAT 7 VAR FI Ui, mr
I FT S EIRE R RAE P12 i U 5 2 HEN 75% 0 PWM % CnRIRIIZR 35D .
AR EARBIRR TS 45, @A B vT LLE 28 th B HE R AR BR AR 1 1% PWM 1 & 3
G2 IR E

6. CCRO Y& T PWM [ HH: AT nBIFE 7 A e i 28 I B 94 32.768kHz, 1fif CCRO
e 256-1, FTLL4HETHIH PWM AN -

2% 256

T= 2><(CCRO+ZD><1 =———5=15.625ms
32768

f
FFE R Z BRI IR . R LA AL, K T=1s /RN, 115 CCcro MME, IF
BHE S NH R ARG 4
7. CCR1 5 ccRO WIELMEN W E T 525t #F CCRO A R FERE Bt 5 Y CCR1 WIEIFS
NAHRLARRS Ak



{4 CCS it - mspA30523 ta L1fispd 3023 ta_L7c - Code Composer Stucio SN il i i

File Edit View Navigate Project Run Scripts Window Help
(mifhe K- B FviE e -

i Project Explorer 22 | 2 %2 7 = O (1) TIResource Explorer | [ mspd30g233_adcl0 12 | [6) mepd30g2nd taii.c £3
5 ADC10_ex]_AVee Reference 377
1 CapTouchBogsterPack Userbxperier| | 4/ Description: This program generates one P output on P1.2 using
 LED Binking 5// Timer A configured for up mode. The value in CCRP, 512-1, defines the PR
= 6// period and the value in CCRL the PWM duty cycles. Using 32kHz ACLK
& mspd30g2a3 adel0 06 7/7 as TACLK, the timer period is 15.6ms with a 75% duty cycle on P1.2.
= msp430g2:33_adcl0_12 8// Wormal operating mode is LPM3.
& msp430g2xx3_ta 17 [Active - Del|| 9// ACLK = TACLK = LFXTL = 32768Hz, MCLK = SMCLK = default DCO.
¥ Binaries 18// //* External watch crystal installed on XIN XOUT is required for ACLK *//
il Includes -
12 MSPA3B62x3
(= Debug 1347 e
[ Ink_mspd30g2553.cmd 1 /I xIn|
[ msp430g2e3_ta17.c 15/ || | 32kn
&) MSP43062553.coxml [Active] pass "IRST "C‘“T}
18 | P1.2/TA1|--> CCR1 - 75% PhH
19
@/ D
21/ Texas Instruments, Inc
22// December 2018
2 Built with CCS Version 4.2.9 and IAR Embedded Workbench Version: 5.19
24
25
26 #include <msp438g2553.h>
27
25 void main(void)
20 {
38 WDTCTL = WDTPW + WDTHOLD; Ve Stop WOT
31 PIDIR |= @x8C; // P1.2 and P1.3 output
32 PISEL |= @xBC; // P1.2 and P1.3 TA1/2 options
33 [ccre = 256-15 | // P Period
34 CCTLT = OUTHOD_ 73 77 CCRI resei/eet
s [T =% 77 TR P Aoty e ls |
36 TACTL = TASSEL T+ C. 13 7T ACLR, up mode
7
3 LeMD; I/ Enter LPM3
9}
a8
a1
‘
. W + | El Consale 22 % Bl ~ 04~ = O|[E problems 52
=S T [ [ _ aan

K A3 Rl FE FPACAS

8. Zk, CATEM T HE FRERKH T PWM PETE .

9. LIEM RS HLIXNEMRL, HIA RS TR AR, 15
TE7N IR P I JE it b B 25 A 2R AT 18 00, IR 48RS (User’s Guide) il
SRR EE,

10. UNTE A an S0 i B 2% R R IR A SR, R A TACTL IR 3 A7 as H AT E
BIAE, TEH P 4R R ] AR B B A7 28 L 1 e W T A R EE R e
X — T XS TACTL BAF s 10 X, A DU B e i 2% A BB Bt 52 th
TASSELx X — L e ), 7527 Hix BLAC B TASSEL_1, RIIEF e I 4% (1) i
N ACLK.



12.3.1 TACTL, Timer_A Control Register

15 14 13 12 11 10 9 8
Unused | TASSELx |
w-(0) w-(0) mw-(0) w-(0) w-(0) w-(0) w-(0) rw-(0)
7 6 5 4 3 2 1 0
IDx | MCx | Unused | TACLR | TAE | TAFFG |
rw-(0) w-(0) w-(0) w-(0) w-(0) w-(0) rw-(0) w-(0)
Unused Bits 15-10 Unused
TASSELx Bits 9-8 Timer_A clock source select
00 TACLK
01 ACLK
10 SMCLK
11 INCLK (INCLK is device-specific and is often assigned to the inverted TBCLK) (see the
device-specific data sheet)
IDx Bits 7-6 Input divider. These bits select the divider for the input clock.
00 "
01 2
10 /4
11 /8
MCx Bits 5-4 Mode control. Setting MCx = 00h when Timer_A is not in use conserves power.
00 Stop mode: the timer is halted.
01 Up mode: the timer counts up to TACCRO.
10 Continuous mode: the timer counts up to OFFFFh.
11 Up/down mode: the timer counts up to TACCRO then down to 0000h.
Unused Bit 3 Unused
TACLR Bit 2 Timer_A clear. Setting this bit resets TAR, the clock divider, and the count direction. The TACLR bit is
automatically reset and is always read as zero.
TAIE Bit 1 Timer_A interrupt enable. This bit enables the TAIFG interrupt request.
0 Interrupt disabled
1 Interrupt enabled
TAIFG Bit 0 Timer_A interrupt flag
0 No interrupt pending
1 Interrupt pending
K] A.4 User’s Guide "X 27 17 2% & XA VEAH 1) i BH
11, 75 G R BRI B TASSEL_1, Z FT PART AR 4 6 a5 1R 09 ACLK, Bl 01, &[N

TESL SO A R TASSEL_1 34T 1 define 1€ Yo AT LLIEIE X TASSEL_1 &+, SRJ5
Fidr, EFHSER PR “open declaration” BE JRIGHIE L.



430g2x33 adcl0_12.c - Co

File Edit View Navigate Project Run Scripts Window Help

Bl KR~ itsy H~ @ HorD I %5 CCSDebug [0~
[ Project Explorer 23] = & 7 = O | (Z) TIResource Explorer [@ mspd30g2:33 adcl0 12.c 52} msp430g2ed_ta 17.c |® mspd30g2553 h =g
S ADC10_exd_AVee Reference e -

[T CapTouchBoosterPack _UserExperier 35 1" AN XIN|-
{5 LED Blinking 2 ﬂ | Breakpoint (Code Composer Studio) 5
5 mspd30g2:33_adc10_06 3977
15 msp430g2x33_adcl0_12 [Active - | 35 // o Undo Cirl+Z
5 mspd30g203 ta 17 31 ﬁ Revert File
P Binaries 32// D. Dang
e 33// Texas Inst] Seve Curls
) Includes
34// December 2 o Declarat B
(& Debug 35// Built wif] pen Declaration sion: 5.18
[ Ink_msp430g2553.cmd R e—— Open Type Hierarchy By prerrrrrreseerres
[8 msp430g2ed ta 17.c 7#include "WSH gpen Call Hierarchy Ctrl+Alt+H L
%) MSP430G2553.coml [Active] 38
39 void main(void Quick Outline Curl+0
- Quick Type Hierarchy Cirl+T
Explore Macro Expansion Ctrle=
ADC1BCTLL = Toggle Source/Header CtlsTab | sample start
ADCIBAEB = @ select
PIDIR |= @xd Show In AlteShiftsW b bt direction
TACCTL® = C
TACCR® = 32 Cut Crl+X |
TACCTLL = Ol Copy CirlsC
TACCR1 = 2; ycle
TACTL = Paste Chrl+V
_ bis_SR_reg e interrupts
Quick Fix Cirl+1
53 Source Alt+Shift+S »
54 // ADC1® inte
=5 #pragma vector Surround With Alt+Shift+Z »
56 __interrupt vq Refactor 4
57 0 |
58 ADCLOCTLe & Declarations L
59  ADC1eCTLO = , [led completely
66 if (ADCIGMEM References 2v?
61 PLOUT &= Search Text v
62  else
63 P1OUT |= @ Team » <=
| I Compare With , ;
r - , ||E Console 3 Replace With » [ O |[EL problems 2 | =
o Licensed Preferences... Writable ‘ Smart Insert ‘ 50:19

516 #define ID @
517 #define ID 1
518 #define ID_2
519 #define ID 3
520 #define
521 #define
522 #define
523 #define
524

525 #define
526 #define
527 #define
528 #define
520 #define
530 #define
531 #define
532 #define
533 #define

a1

Cie
CCIs1
CCIse
sCs
SCCI
CAP
ouTHMODZ
0ouTHMODL

TASSEL @
TASSEL_2
TASSEL_3

K AS ZRHEER

12, B AR RIEY, TLLE BRSSO, X TASSEL_1 #H47 T 52 X, IR LLE
B3 A [FIFEXT TASSEL_0, TASSEL_2 11 TASSEL_3 #H4T 1 & X, ity B LG 4%
o7 R IR = ME > SRR e I 28 A B ERRIE RN TACLK, SMCLK AT INCLK.

Te———a

Eé‘éx%u ) ;"*

input

T

Timer A divider: @ -
1*@x48u /* Timer A input divider: 1 - /2 */
p
2%@xaBu /* Timer A input divider: 2 - /4 */
p
3*@x48u /* Timer A input divider: 3 - /8 */
P
(@*ax1eau) /* Timer A clock source select: @ -
(1*ex1e8u) /* Timer A clock source select: 1 -
(2%@x1e8u) J/* Timer A clock source select: 2 -
(3*ax1leau) /* Timer A clock source select: 3 -
(ex8088) /* Capture mode 1 */
[Rel:lc] /* Capture mode 8 */
p
Bx2e00 /* Capture input select 1 */
p p
Bx1808 /* Capture input select @ */
p p
BxBEDa /* Capture sychronize */
P ¥
(BxBdB8 ) /* Latched capture signal (read) */
\xe1ee /* Capture mode: 1 /Compare mode
p p
BxBese /* Output mode 2 */
P
{BncBBaB ) /* Output mode 1 */

K A6 Sk HE X

TACLK
ACLK

SMCLK
INCLK

B */

*/
=/
*/
*f




3% B

FAQ
1. f¥H Launchpad #ATH R TIER, BT ~BIRRFE RIS EA LTIE?

7E Launchpad FF &R H, BRIAIAME BIRIFAA E4EE, Tl % User's Guide R LA T fif

2, & A BEBIA R B BC AN AE T AME R B B . EIXFIESL R, W
FE 7 I8 G A A A0 SRR AP BB, B A R & e (RSP Bh i A BRI
ysb R, WSROI B A IER TAE. nf DLl R sME iRk, siE e
& 7 i S LA AL ) IR B o

2. ERRANETH SRS ERERERBRE, KIE watch T OHEENEBITURARISE
R

£ CCS A thoxt oy AR B X R EAT T btk, P28, WRIZE LT — AN REkAL
B, WMREREREF PR EARZAER, NZREE watch & HH B IE A IR
{HSEFR L% )5 A8 HIEAE memory HZIERIF, IXANAT DS BAE A 7555 0E. B A
RN AR AR NARAEI, IO R SR AT AR AR, BRI E SO
AR,

3. W@ S SnE (BSL) kXt MSP430 4R ?
BSL /& %3 — M F#i77, Launchpad AT LAFH T BSL, B ART7vEmT &5 LT R :

e MSP430 Programming via the Bootstrap Loader SLAU319B;

e lLaunchpad-Based MSP430 UART BSL Interface SLAA535A,;

e Application of Bootstrap Loader in MSP430 with Flash Hardware and Software Proposal
SLAAQ96;

e Features of the MSP430 Bootstrap Loader SLAA089.
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4. MSP430 [] UART JGvAiA %] UART | A2 AT ik BRI A BUR

— K MSP430 FRIAFIR USART I BA EEH B G, WIAEMA B R EETE
KT XA, ERE R HC S T EE W E UCTL FA7 8 i) SWRST {7t &/ AL
ISR SZ B, AE LA AT, SWRST AL 2B B, 0SB A7 5 5 — ol i ic B 7%
H AR E X USART Hith &4, W4, WiiRGHECE UCTL ZifEds, XFE, SWRST mitk
SO7. kUi 5 UART Byl EACE, SWRST A7 1) B A7/ 5 AL T L Ji /e B il B > 5 it
17, PLIE BT R .

5. MSP430 Flash #1838 1] AR R KBt R 2
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MSP430Flash i PRFFR /D2 100 H.  TEEIEF AT ITAG. TP G2 FIIE 228 35
HB AT DA R B AN HE

6. MSP430 Flash [)5 \ /4R A A% B RAE RT3 £/ ?

MSP430Flash 2544 15 15 N /455 B B & 100,000 k. AT LLEE 884F 50 T i JATG. 2
JF AT fis 2 RV 2235 14 38 0 4R 21 AN EE Ul A

7. 7£ MSP430 1, Wikug 05| HEA H¥reE/?

MSP430 HIEH 10 D EAHBIFIDIRE, X ARG HEME TR KHER], P el L7 Hy
RS AN . 7E G2 &b P A P2 FREA TR ThEE, HFEEERNE AL
BT A (1) GPIO #A R W ThRe . — MR ULAE BT A i 1+ P F P2 B HHITRE S, P AT P2
(R AREAS Hh I T LU Sy 4 A e HLC B R VR B R BRI R W, BTA I P1 IR = —
AT R, FrA I P2 LRI = —ANAE T PL D R & .

8. EREFA% MsP430 HIThEE?

FRAR IO ) 5 5 B R AR 2 (B MSP430 [k R G0k f KPR 32 =) MSP430 4bTKT)
FERES CUCAH LPM3) FITE] . 75 SER BRI FTA B Wl AL 3G RS IS L, LPM3
IR T 2uA.

AR 2 A ) — S5 N D RE A S )

o fEHTHORMEBEAL IS, FEHIFEF R .

o HMEBEER{ HE T R LTI

o [ERMRIIFEII S MBI 5 . B0 Timer_A Al Timer_B ] A H 24
PWM 37 Fli SRAMES E I 1T A i AT CPU B

o EAITHE Y SO PG BRI ) B B AR B R

o EGPIE TR AN R B0 H DA BRI A T

o TTRCKMARER, fRUFH ] CPU A AR

o DRI ARM 3 51 AT R, I H i E R -

9. MSP430 DCO FIBEE Blahg?

DCO HEHURA W DCO 4%, fDCO 1 fDCO+1, FHUAFZZEAT- fDCO Fil fDCO+1 Z [A] [I4
Ko XFERR TS B T T BT AT R i e R ) A S e B 2l e AR 1 B A
AT R, IR P R R R TR — N e AR, N T R RET(EMI) .

DCO Ml 2 B I AN L IS AR AR T A BT sl 35 2 Bl s PF 80 5% Deo iR
o VEEAT AT L AR ) ANAS E i i DCO I I L3N .
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WRAEH WAL R E 0 GIE M BN, AW ERK S . IEFEIEN T, ERBRS
R, GIE P g B . Kk, WRAREE — Nl 3 ERE RS — AR, o
ZUAE R W AL BE e B K GIE 2B AL, WS H 7 $8 Fd 1 System Resets, Interrupts, and

N = X

Operating Modes X" B 4 »
11. MSP430 3 1 5] B o BT B VS ROE R B SE R 2K ?

Uity 11 5] B0 T2 A RO BT DL B . P AT DO AN 5] Bk R B e R R

. VERAE MSPA30x3xx NG A 1 TH B m & 1) P0.0 A1 PO.1 I Wiks 24 B

HEE. EHAMEA P 5 L, PR EAS HINER, H P LIS E.
S FARAT— AT BRSSO rR W, Bk T RS OT f rR W REAL,  {EAR S ZF A7 2% 1 42 =) B

fEREAL(GIEy A B L. HEAEE, WES A F8rE H T 1/0 A E .

12. BT 32.768kHz [ @M=, MSP430 B ] LLE £ KM M SRt R T/E?

MSP430x3xx 24 Wit et T 1 32KHz B ERTR, AR A — ST i N BB 2 1l R
Yits (DCO) H=A—ANWEBHIER 8D (MCLK) « MSP430x3xx 254414 F FLL HLE&{# MCLK
FasE 2 H P AT 75 B4

MSP430x1xx Ml MSP430x4xx #sfh B A — AN SCHFF 32KHz B34 o & il 10 ik . A ik
MSP430x1xx Fl MSP430x4xx iIEH 75— AN ddR, XA IRIOCCR S E M MR, X, s
TE A — I 2 — AN B A dn R R 82 284k b BLAE 75 R my DL R A o —A~

MSP430x1xx Fl MSP430x4xx #5118 HA 7] 4 FL (1 56 DCO, DCO A] LAYESM ST FATA0] df % 1)
TSR P2 A E I e . 8L T MSP430x3xx, MSP430x4xx #eft-tdi Fl FLL R4l DCO faiE %
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13. MSP430 HF# A MNAE 2 2 K7

MSP430 54 TI braEef RN ANAS,  H HaA B0 i S M AR, B0 46 A1 Bl B B o 11
GBI T AT R BRAE i AN N MSP430 #8412 4T I (Human Body Model=1.5KV, Charged
Device Model=500V and Machine Model=200V).

14. MSP430 #4 T/EM-FEERTEE A7

555 b Z s F PR I A TR T MRS AR AR VG . MSP430 Z3fF & Bttt LAk
) TP IR Y - 40C £+85°C o Bl FAAERE, A TRIEEEHIA S TAREIXAME S
FElAh o 52 D 0% PEAR RO TR 17 A PTG REAIAN TT G A2 1A 1 46 (A A L BE VS T

15. M A MsPa30 BEATEIEFE BRI R ?

fE4] MSP430 #81F A AR B A bk 28 . AR, B AN B s A ds vl LUE AT 1/0.
B AN 12C B AT A% 2% EEPROM AT FH T HIE /25 259



16. £ MSP430 B BAH HHAY —RKE?

/5 A P 4P R, T A A A B L P O B B o o
10282 P B T LA A5 AR SR BB A, T B 0 53 — B — A B 31
Vee, S—AMEBE] Vs, —E R RMRTAE IIGER / - 2mA. 2R A HORT
ARG ST

17. ZEBBE AT LAFRE) 430 FF R TR HIE 2

— R 430 BT K AT /D E: H RS (user's guide) , 8 1T B &AM DL
CPU HRERVELN TN RENH LA AT 7718 BEFM (datasheet) , B8 186 BV ERRRE,
IR HESE; LS ERIY (code examples) , 1] LLFEEHFRA TR 46 & TAE. BT
PN O — & R AW E A R, RHo I RS o] DU IS Bk =2 SR 2 A
%o NTHIFE, v AR E PO SR TGk B . X ey AR 0] DAZE T B I B3R EF,
o EEAE 430Ware B3R F,

FANNLE AR s, £ LW DERBFER, I HECNE T wis:
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